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WHAT'S NEW

MICOLLABMITEAM DATA CENTER LOCATION
You can now set the location of theMiCollabMiTeam data center in the Service Provider Portal
to support Data Sovereignty requirements. Oria 5.3 with MiCloud Business 3.3 supports three
locations for hostingMiTeam user data; US (default), Europe, and China.

If you upgrade to Oria 5.3 but usingMiCloud Business 3.2 or earlier, theMiTeam data center
location is set to US by default and is read-only.
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ORIA OVERVIEW
Oria is a customermanagement solution for service providers usingMitel® MiVoice and
MiCollab products enabling the delivery of multi-customer hosted communications services. It
allows a service provider to manage and deploy hosted services to their customers. At the same
time, Oria allows a service provider to offer each of their customers an administration and self-
service portal to make site specific adds, changes, deletes, and upgrades and downgrades of
user services.

The goal of Oria is to cut down on administration operations andmake it easier andmore efficient
for a service provider to offer and deploy services to their customers. Phone users that are
created for a customer have access to a variety of phone features defined by their assigned
feature set.

Service providers manage and deploy hosted services to their customers through theMitel
MiCloud Solution (MiCloud). MiCloud can be deployed in one of twomodels:

• Small Business (SB)
• Medium-Large Business (MLB)

The SB deployment model uses theMiVoice Business Multi Instance platform installed on
Industry Standard Servers (ISS) running theMitel Standard Linux (MSL) operating system.
Virtual LANs are not supported in this deployment scenario. In Oria, this is referred to as MiCloud
Business Multi-Instance.

TheMLB deployment model uses MiVoice Business virtual installed as an .ova file on a virtual
machine running VMware vSpere. In Oria, this is referred to as MiCloud Business Virtual.

See theOria Engineering Guide for details about the Oria platform.

CUSTOMERADMINISTRATORSELF-SERVICE
PORTAL

The Customer Administrator Portal (CAP) is designed with critical tasks in mind that should be
completed in sequence. For instance, the recommended workflow starts with defining a
company’s Business Hours to set up how incoming calls are received and handled at your
company's main number(s).

Company Users Groups SharedDevices AutoAttendant Call Flows

Additionally, CAP always provides context-sensitive help wherever youmay be in the task-flow.
For example, the available help resources are shown below for the Business Hours task within
the overall administrator workflow.

http://edocs.mitel.com/UG/EN/Oria/5.1/Customer_Administrator_Portal_Help/index.htm#Customer_Admin/Company/Company.htm
http://edocs.mitel.com/UG/EN/Oria/5.1/Customer_Administrator_Portal_Help/index.htm#Customer_Admin/Users/User.htm
http://edocs.mitel.com/UG/EN/Oria/5.1/Customer_Administrator_Portal_Help/index.htm#Customer_Admin/Teams/Group.htm
http://edocs.mitel.com/UG/EN/Oria/5.1/Customer_Administrator_Portal_Help/index.htm#Customer_Admin/Shared Devices/Shared_Devices.htm
http://edocs.mitel.com/UG/EN/Oria/5.1/Customer_Administrator_Portal_Help/index.htm#Customer_Admin/Auto_Attendant/Create_Auto_Attendant.htm
http://edocs.mitel.com/UG/EN/Oria/5.1/Customer_Administrator_Portal_Help/index.htm#Customer_Admin/Call_Flows/Call_Flows.htm
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PLAN
Before system installation and setup, complete an analysis of the potential customer base that
hosted voice will be sold to. During the analysis, the goal is to discover the following:

• Target customers and type of end users
• Common phone features used by target users
• Expected dial plans
• Local dialling codes for each city where customers may exist

Upon producing the results for the customer analysis, it is necessary to determine how the
various features will be packaged into Feature Profiles and bundled with portal features to satisfy
themajority of target users. Dialing privileges are also designed at this stage to include all
potential customer locales and their various local dialing codes. This will reduce lost time later
when a default database update is required to include a new Dial Privilege.

The following generic business requirements need to be set for all customers:

• Bundles/Feature Profiles
• Dialing Privileges
• Key Templates
• Brands
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INSTALL
Install Oria as a software blade onMitel Standard Linux (MSL), or as a virtual appliance running
on a virtual machine.

For information about the installation and setup of the voice platform (i.e. MiVoice Business
Multi-Instance, MiVoice Business Virtual , MiVoice Business, MiVoice Border Gateway, etc.) or
for proper network configuration, please refer to the appropriate Mitel product-specific
documentation.

The procedures described here assume that all networking has been configured according to the
Hosted Deployment model as described in the Oria Engineering Guidelines. To ensure that Oria
operates properly, select an IP address that is available within the appropriate network or subnet
to allow access to the appropriate voice platform.

Important: TLS 1.0 has been found to be vulnerable to a number of security attacks. As such,
Oria 5.3 disables support for TLS 1.0 by default. Mitel does not recommend using TLS v1.0.
However, should you need to enable support for TLS v1.0, login to theMSL server manager for
the server at:
[http://<address]http://<address of Oria server>/server-manager,
go toSecurity > Web Server > TLS and select Allow TLS v1.0.

After Oria is installed, youmust Configure the following parameters:

• Network Time Protocol (NTP)
• Keyboard/Time Zone/Locale (during the installation of MSL)
• HTTPSWebCertificate

INSTALL ONA PHYSICAL SERVER
TheOria software blade is installed from the blade panel in theMSL Server Manager. Installing
and activating the Oria software blade consists of the following steps:

• Logging in to theMSL Server Manager.
• Loading the software onto theMSL Server from theOria CD, and then accessing the
blade panel in theMSL Server Manager to install the Oria software blade.
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COLLECTSITE INFORMATION
The following table itemizes the information you will need on hand during installation and
configuration. For efficient installation, it is recommended that you gather this information
beforehand.

• Administrator Password
• Domain Name of MSL Server
• System Name of MSL Server
• Gateway IP Address
• IP Address of your external NIC
• System IP Address for the Oria blade

To install Oria on a physical server
1 Place the CD in the optical drive.

2 Login into the Server Manager using a supported browser with the user name 'admin' and the
root password you gave when configuring theMSL server. The Server Manager is accessed
by entering the following URL:http://<www.hostname> OR <IP address of the MSL
Server>/server-manager.

3 Click onBlades, located in the left-side panel under the ServiceLink heading.

4 Click Update List to ensure an up-to-date listing of software blades.

5 Click the Install link, located beside the Oria blade name.It may take a few minutes for the
software to install.

6 Test the installation:

7 Click onOria, located in the left-side panel under theApplications heading.

8 If Oria is not visible, refresh the browser.

9 Click Launch, located in themain window.

INSTALL ONA VIRTUAL MACHINE
Oria is installed using the vSphere Client connected directly to the VMware ESX/ESXi 5.0, 5.1,
5.5, or 6.0 server or through the vCenter Server.

Installing and activating the Oria virtual software consists of the following steps:

• Logging in directly to the ESX/ESXi hosts or to the vCenter Server using the vSphere
Client application.
• Deploying virtual Oria as a virtual machine and virtual application operating on VMware
vSphere 5.0, 5.1, 5.5 or 6.0.
• Powering up the Virtual Machine and commissioningMSL/Oria.

COLLECTSITEREQUIREMENTS
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The following table itemizes the information you will need on hand during installation and
configuration. For efficient installation, it is recommended that you gather this information
beforehand.

• Administrator password - For password strength, choose a password that contains a
mix of upper and lower case letters, numbers, and punctuation characters, and that is
not a dictionary word.
• Domain Name of MSL Server - The domain on which theMSL server is installed, i.e
abc.com.
• System Name of MSL Server - Names must start with a letter; can contain letters,
numbers, and hyphens. Also known as the host name.
• MSL Server IP Address Subnet mask and Gateway IP address - TheMSL Server
IP address This will also be the IP address for the Oria blade. An appropriate subnet
mask for theMSL Server IP address. The IP address of the router.
• vSphere Client application installed on a PC - The vSphere Client is used to
deploy Oria. The vSphere Client acts as a console to operate virtual machines and as
an administration interface into the vCenter Server systems and ESX/ESXi hosts.
Refer to the VMware website for detailed installation procedures and additional
documentation.
• (Optional) vCenter Server(s) installed on the network - A service that acts as a
central administrator for ESX/ESXi hosts connected on a network. This service directs
action on the virtual machine and the hosts. The vCenter Server is the working core of
vSphere. Refer to the VMware website for detailed installation procedures and
additional documentation.
• ESX/ESXi 5.0, 5.1, 5.5, or 6.0 installed on the server - Use the latest software
version as specified in theOria Engineering Guidelines.

INSTALLING ORIAUSING ANOVF TEMPLATE
This installation procedure assumes that a VMware server has been installed and is running an
ESX or ESXi operating system.

To install Oria on a virtual machine
1 Install VMware vSphere client as follows:

2 Open a web browser and enter the IP address of the VMware server.
• Click Download vSphere Client to download the client.
• Run and complete installation wizard.

3 Retrieve the latest Oria OVF template (Oria.ova file) fromMitel Online (MOL).

4 Open the vSphere client to connect to the virtual machine:
• Enter IP address of VMware server.
• Login as the root user.

5 Click File→Deploy OVF Template. . . . The Deploy OVF Template screen displays.
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6 Select one of the following:
• Deploy from file if the OVF template file was downloaded to the local computer or to a
network share drive, then click Browse to locate the file.
• Deploy from URL if the OVF template file is on the internet or accessible through a web
browser; enter the URL of the location of the file.

7 Click Next. TheOVF Template Details screen displays. Leave the default selections as is.

8 Click Next. The end user license agreement screen displays.

9 Click Accept to accept the license agreement, then click Next. The Deploy OVF Template
Name and Location screen displays.

10 Enter ameaningful name for the Oria virtual machine, or accept the default name. Click Next.
The Deploy OVF Template Disk Format screen appears.

11 Click Thick Provisioned Lazy Zeroed. Click Next.

12 If the network defined in the OVF template doesn’t match the name of the template on the
host to which you are deploying virtual Oria, you are prompted to configure the network
mapping. Contact your Data Center administrator for more details about which Network
Mapping to use.

13 Click Next.

14 Review the information Select Power on After Deployment. Click Finish.
Note: This process may take up to 10minutes to complete depending on network traffic
and the performance of the server.

15When the dialog indicating that the deployment is complete appears, click Close. vOria
appears in the inventory list in the left side navigation pane.

16 Click on the newly created Oria Virtual.

17When theOria Virtual has powered up, you can begin configuring theMSL server.

To configure the MSL server:
1 Open the virtual machineMSL Server Console in one of the following ways from within the

vSphere Client:

a Right-click on the newly created Oria Virtual and select Open Console.

b Click the Launch Virtual Machine Console icon in the tool bar.

Note: VMware Tools are pre-loaded as part of Oria Virtual.

c Click theConsole tab in themain display window.

2 TheMSL Server Console window appears. Place and click the cursor in the console window to
continue. If at any time you want to have the cursor available for other desktop activities,
press theCTRL + ALT.

3 Follow theMSL server configuration procedures as described in theMSL Installation and
Administration Guide.
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4When theMSL server configuration is complete, it might be necessary to add a local network
toMSL if you intend to access Oria Virtual from a different network from which it is installed.

a From the Server Console, select 9 - Manage Trusted Networks.

b Click Add a new trusted network.

c In theNetwork Address field, enter the IPv4 or IPv6 address of the network to
designate as “local”.

d In the Subnet mask field, enter the dot-decimal subnet mask (for example, 255.0.0.0
if you intend to open up to the entire Class A subnet).

e In theRouter field, enter the IP address of the router you will use to access the newly-
added network.

f Click Add.

5When theMSL server configuration is complete, it might be necessary to add a local network
toMSL if you intend to access Oria Virtual from a different network from which it is installed.
The process consists of adding a local network, subnet, and router to the Local Networks
panel in the server manager as follows:

6 Log in using the admin user ID and root password created during theMSL server configuration.

a Using the arrow keys, select 11 - Access Server Manager.

b Log in using the same administrator user ID and password as inStep a.

c Using the arrow keys scroll down to Local Networks.

d Use the down arrow key to select Add Network. Press ENTER.

e Use the down arrow key to enter the following information:

• Subnet Mask (for example, 255.0.0.0 if you intend to open up to the entire Class A
subnet).

• Router Address (for example, 192.168.1.x, the gateway IP provided during theMSL
server configuration).

f Use the down arrow to select Add, then press ENTER. A status screen displays
indicating success at creating the Local Networks.

g TypeQ to quit, then select Exit andYes.

h Using the down arrow key, scroll to Exit from theMSL Server Console.Press
ENTER.

i You are now ready to configure the Oria application.

7 Confirm theOVFmemory and HDD configuration as follows:

a Right-click the newly created Oria virtual machine.

b Click Edit Settings.

c Under theHardware tab, click Memory and set Memory Size to 6 GB.

d Under theHardware tab, click Hard Disk and set Disk Provisioning to 50GB.
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e Under theHardware tab, click CPUs and set Number of Virtual Sockets to 4.

f Click OK.

8 Complete the OVF configurations as follows:

a Click Power → Power On.

b Click theConsole tab and wait for server to startup. Login as root user (use password
provided by Mitel).

c Select Timezone Configuration and set it based on your location. Click OK.

d Select Keyboard Configuration and set it based on your preference. Click OK.

e Select theNetwork Configuration option.

f Select Edit Devices → eth0.

g Uncheck theUse DHCP checkbox.

h Enter the appropriate Static IP, Netmask, and Default gateway IP address.

i Select Edit DNS Configuration and enter a Primary DNS server IP address.

j Click OK → Save → Save&Quit → Quit.

k Right-click the newly created Oria virtual machine.

9 Click Power → Shutdown Guest.

10 Right-click on the Oria virtual machine.

11 Click Power → Reset.

INSTALL ORIA PLATFORMMANAGER
To enable the Platform Manager features, install Oria File Server andOria Platform Manager on a
new server. Do not install them on the same server you installed Oria.

You can install the Oria File Server andOria Platform Manager on the same server.

Install the following software blades:

• Oria File Server
• Oria Platform Manager

TheOria software blade is installed from the blade panel in theMSL Server Manager.

To install Oria File Server
1 Place the CD that contains theMSLOria File Server software blade in the optical drive.

2 Login into MSL Server Manager.

3 In the left-side panel under ServiceLink, click Blades.
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4 Click Update List to ensure an up-to-date listing of software blades. If there is a report
displayed from the last install, click Clear this Report.

5 In theCurrent List of Blades table, find theOria File Server blade and click the Install link in
the Installation column.

6 Accept the license agreement. It may take a few minutes for the software to install.

7 Click CTRL R to refresh the page.

8Wait a few minutes for the application to start up.

9 In the left-side panel underApplications, click Oria File Server.

To install Oria Platform Manager
1 Place the CD that contains theMSL software in the optical drive.

2 Login into MSL Server Manager.

3 In the left-side panel under ServiceLink, click Blades.

4 Click Update List to ensure an up-to-date listing of software blades. If there is a report
displayed from the last install, click Clear this Report.

5 In theCurrent List of Blades table, find theOria Platform Manager blade and click the
Install link in the Installation column.

6 Accept the license agreement. It may take a few minutes for the software to install.

7 Click CTRL R to refresh the page.

8Wait a few minutes for the application to start up.

9 In the left-side panel underApplications, click Oria Platform Manager.



Configure Default Database

15

CONFIGURE
You can now create a default MiVoice Business Platform database. Any operations performed in
the portal will make direct changes to the tables within theMiVoice Business Platform database.
For the portal to perform properly with eachMiVoice Business Platform instance, configure the
instances with the same default MiVoice Business Platform database.

Platform Manager can create platform instances from a blueprint. See Create a Platform Group
using a Blueprint for more information.

CONFIGURE DEFAULT DATABASE
Before creating a customer and allowing a customer administrator to perform self-service
operations, you need to setup a default MiVoice Business Platform database that can be applied
to eachMiVoice Business Platform instance.

The default MiVoice Business Platform database is based upon the information gathered during
the system planning phase. It is a combination of configurations to satisfy system requirements
for feature profiles (COS), bundles, dial plans, and default settings. The template is then applied
to every MiVoice Business Platform instance to provide the same level of features and services
to all customers.

Note: The Platform Manager installation includes some reference golden database files. You
can find them on the Platform manager server, under the linux directory /opt/dist_oria-bim-
setup/reference.

Prior to performing any configuration operations on the default MiVoice Business Platform
database, it is necessary to ensure that all requirements have been satisfied and included in the
default database. There are two parts of the default database that can be defined as follows:

• Fixed Defaults - Oria Default Configurations (these are fixed in Oria and cannot be
changed)
• Flexible Defaults - Business Requirements Configurations

FIXEDDEFAULTS
The fixed defaults refer to the settings that must be configured on the default MiVoice Business
Platform database to ensure proper interaction betweenOria and theMiVoice Business Platform.

When a user, hotdesk phone (IP device only), or call group is created using Oria, there are
specific settings that Oria applies, and thesemust match those on theMiVoice Business
Platform, to ensure it responds correctly (i.e. when a hunt group is created, Oria sets the Class of
Service to COS 6).

The table below shows the default values that Oria uses, and these values must be identical to
that configured on the default MiVoice Business database. Use this table to plan and configure
the default database.

Important: There are several pre-configurations that must be performed on theMiVoice Business
before it can be provisioned by Oria. It is important to read the Oria Engineering Guidelines first,
before configuringMiVoice Business in Oria.
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Notes:
Index #1 in the Call Rerouting Always Alternatives and the Call Rerouting First Alternatives
forms must be blank (or will be overwritten by Oria).
Index #2 in the Call Rerouting Always and First Alternative #2must be set to DN configured
through theOria Portal.

OPERATION SETTING VALUE DESCRIPTION

COS Defaults

Hotdesk Phones 1/1/1 Day/Night1/Night2

Standard Phones Any

MiCW default is
11.
Recommendation
is to use COS 11
for theMiCollab
environment

Hunt Groups 6/6/6 (MiVoice) 25/25/25
(MiCollab)

Day/Night1/Night2
MiCW default
value is 25.

Ring Groups 6/6/6 (MiVoice) 26/26/26
(MiCollab)

Day/Night1/Night2
Will need to
override theMiCW
default value of
26.

EHDU Extensions 11/11/11
Day/Night1/Night2
MiCW default
value is 11.

COR Defaults Hot Desk Phones 1/1/1 Day/Night1/Night2

DID Trunk
Attributes DID Digits to Absorb Value that will generate a

7 digit number string.

Oria requires a 7
digit local number
after the process
of absorbing the
DID digit string.
For example, in
North America, the
digits to absorb
will be 3 if the
regional dialing
plan is 10 digits
and 0 if the
regional dialing
plan is 7 digits.
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OPERATION SETTING VALUE DESCRIPTION

Voicemail
(EMEM)

Configuration

Voicemail COS *Any

Enable options: -
COV/ONS/E&M
Voicemail Port -
MessageWaiting -
Voicemail Softkey
*Use any available
COS for voicemail
(ports/hunt group)

Vmail Ports *Any

Assign Voicemail
COS *Create as
many vmail ports
as necessary

Vmail Hunt Group *Any

Assign: -
Voicemail COS -
Vmail ports *This
is a configurable
value (in the
Settings tab when
creating a Platform
Group), and once
assigned to a
customer it cannot
change.

Call Rerouting First
Alternative 2

Set as 'THIS' for
all options to
forward to
voicemail hunt
group (6000).

Call Rerouting Always 2

Set as 'THIS' for
all options to
forward to
voicemail hunt
group (6000).

Voicemail
(NuPoint)

Configuration

Voicemail COS Any

Use any available
COS for
voicemail. The
MiCW default
value is 82.

Voicemail MWI COS Any
Use any available
COS for
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OPERATION SETTING VALUE DESCRIPTION

voicemail. The
MiCW default
value is 84.

Voicemail Ports Any

Assign Voicemail
COS. Create as
many voicemail
ports as
necessary. The
MiCW default is to
choose port
numbers
incrementally after
the Voicemail
Hunt Group
number (eg. if the
Voicemail Hunt
Group number is
6000, the default is
to start from 6001).

Voicemail Hunt Group 6000 (MiCollab) 7000
(vUCC)

Assign: •
Voicemail COS •
Voicemail ports

Call Rerouting First
Alternative 2

Set as 'THIS' for
all options to
forward to
voicemail hunt
group (eg. 6000).

Speech Auto
Attendant

Configuration
Speech Auto Attendant COS Any

Use any available
COS for Speech
Auto Attendant.
TheMiCW default
value is 85.

Mitel
Collaboration
Advanced

Configuration

Mitel Collaboration Advanced
COS Any

Use any available
COS for MCA.
TheMiCW default
value is 86.

Default CESID Enable Automatic CESID True
Allows user and
hotdesk phone
creation to occur
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OPERATION SETTING VALUE DESCRIPTION

successfully

Registration
Access Code
Configuration

Set Registration Access
Code

Enter a string from 3 to 10
characters long to use
when registering a new IP
telephone. The access
code followed by the DN
constitutes the PIN and
can include the
characters # and/or *.

Is required for
creating a
MiCollab
Client Tenant
in a platform
group. If not
set (blank),
Oria displays
the error
message
"MCD does
not have the
registration
code set"
when you try
to save the
platform
group.

FLEXIBLEDEFAULTS
The flexible defaults refer to the settings that must be configured on the default MiVoice
Business Platform database to ensure proper interaction betweenOria and theMiVoice Business
Platform instance corresponding to the bundle and dial plan assignments.

A bundle and dial plan are assigned to each newly created user. A bundle includes a Feature
Profile, which is Oria's view of a Class of Service (COS). When a user is assigned a bundle, the
COS number affiliated with the bundle gets assigned to the user on theMiVoice Business
Platform.

Similarly, a dial plan in Oria corresponds to a Class of Restriction (COR) on theMiVoice
Business Platform. When a user is assigned a dial plan, the COR that is registered to the dial
plan gets assigned to the user on theMiVoice Business Platform.

To ensure that proper services (COS options and ARS routes) are available to an end user, it is
essential to set the Flexible Defaults appropriately.

If any of the User features that affect theMiCollab Client aremodified either throughOria or
directly on theMiVoice Business System Administration Tool, then the changes will not be
reflected on theMiCollab Client until it has been Synchronized with thoseMiVoice Business
instances affected.

CREATETHEDEFAULTMIVOICEBUSINESSPLATFORM
DATABASE
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To create theMiVoice Business database for the first time, it is necessary to use the fixed and
flexible defaults listed above, and any other additional customer requirements that may arise.
Once this information has been collected, the default database can be created and then applied
to eachMiVoice Business Platform instance, using one of the followingmethods:

• MiVoice Business Import Spreadsheets
• Configure an initial MiVoice Business, then Backup and Restore on other MiVoice
Business instances

To create the Default Database using MiVoice Business Import Spreadsheet:
1 Export the 3300ICPImportSpreadsheet.tar.gz using the Embedded SystemManager (ESM)

from a form that has the Export button.

2 Unzip the file to get the containing the 3300ICPImportSpreadsheet.tar file.

3 Unzip the 3300ICPImportSpreadsheet.tar to get the containing
3300ICPImportSpreadsheet.xls file.

Note: Ensure that the filename extension is ".xls". Filename extensions with ".xlxs" are not
supported.

4 Open the spreadsheet, enablemacros and create the following spreadsheets for the De- fault
MiVoice Business database:

• Default CESID
• Class of Service Options
• VM Ports
• Station Attributes
• Hunt Groups
• Hunt Groups - Hunt GroupMembers
• Call Rerouting Always Alternative
• Call Rerouting
• Class of Restriction Groups
• Trunk configuration forms (eg. SIP Peer Profile, IP/XNET Trunk Profiles, and any
additional forms that may be required)
• ARS Routes
• ARS Dialed Digits
• ARS Leading Digits
• ARS Digit Modification Plans
• Trunk Attributes
• Embedded UM Settings
• System Options

5 Enter all of the following required and appropriate information into spreadsheets:
• Required Oria defaults (voicemail, COS, COR, Default CESID, DID trunk).
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Note: Make sure your COS values are set up correctly. If you create a RingGroup with
Voicemail and use it in a Call Flow, the call will route to Voicemail instead of the selected
Overflow Point. This happens because the COS Call Forward No Answer Timer is set to
15 seconds while the default Overflow timer in the RingGroup is set to 20 seconds. The
COS option will trigger before the Overflow Point thus routing the call to Voicemail.
• To enable Customer Administrators to create call flows that do not follow business
hours, set the following COS values:

a Third Party Call Forward Follow MeAccept =Yes

b Third Party Call Forward Follow MeAllow =Yes

c UseHeld Party Device for Call Re-routing =Yes

• Business requirements (COS - Feature Profiles, ARS - Dial Plans)
• Go to the SharedOptions form and set "DPNSS/QSIGDiversion Enabled" to Yes.

6 For each sheet completed in Step 4 above, check the Data Format and Save For Import.

7 Use the output spreadsheet file to configure eachMiVoice Business instance with this default
database.

8 Follow these guidelines:
• DID Configuration: Set the number of DID digits to absorb or insert for an incoming
DID call (ensure that the DID trunk is set to absorb or insert all digits required to allow
for ten digits to pass into theMiVoice Business instance).
• Hardware Defaults: If the hardware defaults to not fit deployment requirements, refer to
SystemMaintenance.
• Call Rerouting: 6080 - 6099 will be used as pilot numbers in MiVoice Business.
• Rows 20 - 39 (inclusive) in Call Rerouting Always and Call Rerouting 1st Alt forms are
reserved for Oria. Any changes to Call Rerouting in Oria will change the values in these
rows of these two forms.
• Configuration Changes: Any changes to the default MiVoice Business databasemay
require substantial reconfiguration of the Oria application to ensure that there are no
discrepancies across the entire service offering.
• Do not attempt to perform multiple loading tasks at the same time as the Import. Those
tasks being loaded at the same time as the Import will fail. It will be necessary to retry
those loading tasks independently.

To create an Initial MiVoice Business, then Backup and Restore on other
MiVoice Business instances:
1 Use theMiVoice Business Embedded SystemManager (ESM) to configure the initial Mi-

Voice Business instance.

2 Test to ensure that the configuration was performed successfully.

3 Backup theMiVoice Business database.

4 Use the saved database backup file to configure eachMiVoice Business with this default
database.
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SinceOria allows for programming Embedded UnifiedMessaging in user mailboxes, and
Forward to Email in user mailboxes, the system programming requirements for these should be
part of the default MiVoice Business database programming requirements.

Embedded UnifiedMessaging needs to be enabled on a system-wideMiVoice Business basis in
the Embedded UM Settings form. For Forward Voicemail to Email, the SMTP server needs to be
configured in the System Options form on theMiVoice Business instance(s).

To set up Embedded Unified Messaging:
1 Go to the Embedded UM Settings form on theMiVoice Business instance(s).

2 Program the following fields:
• Enable Embedded UM: Yes
• IMAP Server: The IP address of your IMAP server
• IMAP Server Connection Type: Either CLEARN, SSL, or STARTTLS
• IMAP Server Port: The port used by your IMAP server (typically 143)
• IMAP Server SSL Port: The port used by your IMAP server (typically 993)

3 Go to theSystem Options form.

4 Program the following fields:
• Email Server:- The IP address of the SMTP server
• Email - Sender's Address: - Enter an email address

REGISTERMIVOICE BORDERGATEWAY
There are several pre-configurations that must be performed on theMiVoice Border Gateway
(MBG) before it can be provisioned by Oria. It is important to read the Oria Engineering Guidelines
first, before registering anMBG in Oria. If the network configuration includes aMiVoice Border
Gateway (MBG) Cluster, it must be registered with the portal so that it can be assigned to a
Platform Group. For proper registration, theMBGmust exist and be reachable from Oria.

When registering anMBG, it must be based on what device types are allowed to be programmed
on the particular MBG:

• MiNet MBG
• SIP MBG
• MiCollab Client

Each Site will be able to select anMBG for each device type and will allow 1MiNet, 1 SIP, and 1
MiCollab Client device type, while each Platform Group can havemultiple Sites with different
combinations of MiNet, SIP, andMiCollab Client deviceMBGs.

PC MiNet Softphone phone types are programmed on theMiCollab Client deviceMBG; however,
Oria will not allow a cluster zone to be specified.

DIDs can be assigned against one (or none) of a number of multiple MBGClusters. For each DID
range, anMBGCluster and SIP Trunk can be selected.
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DID Services can be assigned to aMiVoice Business platform or aMiVoice Border Gateway.
DIDs are required in both theMBGSIP Trunks andMiVoice Business. TheMBG needs DIDs to
determine whichMiVoice Business gets the call and theMiVoice Business needs them for DID
Services.

EMBEDDEDMIVOICEBORDERGATEWAY
Certain Platform Groups have anMBG embedded within that platform. The following platform
types contain an EmbeddedMBG:

• MiCollab
• MiCollab with Voice

The EmbeddedMBG is categorized as follows, based on the type of device that can be
programmed on it:

• MiNet Devices
• SIP Devices
• SIP Trunking (Routing Rules)

When creating a Site or registering a DID range for aMiCollab or MiCollab with Voice platform
group, the EmbeddedMBG is included in the list of MBGClusters, if it was registered. An
EmbeddedMBGwill only appear in the platform list to which it belongs.

When a user is created and assigned to a Site with an EmbeddedMBG, then the device will be
programmed on the EmbeddedMBG if the EmbeddedMBG is assigned to the device type that
was assigned to the user.

When a Hot Desk device is created and assigned to a Site with an EmbeddedMBG as theMiNet
DeviceMBG, then the device will be programmed on the EmbeddedMBG.

WhenDIDs are registered for aMiCollab or MiCollab with Voice Platform Group, if the
EmbeddedMBG is specified as theMBG, then the routing rules for those DIDs are programmed
on the EmbeddedMBG. If another MBG cluster is specified, then the routing rules for those DIDs
are programmed on that MBG.

If a MiCollab or MiCollab with Voice Platform type is not in use, you can delete it (it will also
delete the EmbeddedMBG).

Notes: It is possible to register the sameMBG twice by mistake, once with the IP address, and
once with a Fully Qualified Domain Name (FQDN). Oria does not detect that the IP addresses
are the sameMBG. This will not cause any issues in Oria (other than it being treated as two
separateMBGs) but may confuse the administrator. It is recommended that MBGs be
registered in a consistent manner.
Ensure that Web Services have been enabled on the configured standaloneMBG. Otherwise
communication between theMBG andOria will fail.

To register a MBG Cluster and assign it to a Platform Group

Registering anMBG cluster configures the DNS Server record on the DNS server to provide the
MBGFQDN to theMBG cluster member hostnamemapping.

1 From thePlatforms tab, click theMiVoice Border Gateways tab.
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2 Click Register MiVoice Border Gateway Cluster.
Note: If you register anMBGCluster after adding users, the changes that youmake to
the Public Facing FQDNs are not updated in theMiCollab Client User Settings. To
update the settings and send users the updatedMBG information (SIP username, SIP
password, and external FQDN), resend theWelcome email.

3 Enter details and then click Submit.
It is important to enter theMSLUsername and Password in the appropriated fields when
registering theMBG. Otherwise, the registration will fail.
You will need to re-enter theMSLUsername and Password credentials when doing edit
operations (such as when editing a Platform Group).

CONFIGURE SERVER FORWELCOME EMAIL
Youmust configure SMTP on theMSL server to sendWelcomemessages from Oria.

1 In theMLS server manager under Configuration, click E-mail Settings.

2 Configure the SMTP server as follows:
• Server to use for outbound SMTP: Enter the server hostname or IP address in this
field.
• Destination Port for Outbound SMTP: Select a port for the SMTP. Available ports:
SMTP Port 25 (use cleartext; default) SMTP port 587 (TLS encryption) and SMTP Port
465 (SSL encryption)
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SET UP PORTAL
Before creating customers, a service provider must perform a set of tasks to set up the portal for
service. The setup ensures proper service to all customers so that it will communicate with all
pre-configured Platforms properly when an operation is performed (e.g. a user or call group is
created). Prior to creating a customer, each pre-configured Platform must be registered using the
Oria portal. Also, all bundles and dial plans must be registered and created using Oria to ensure
that customers receive the desired services.

Administrator bundles are assigned to customers that contain the Users feature, at aminimum,
and no Phone Features. The customer will then be able to perform user moves, adds, changes,
and deletes without contacting the service provider. Here are the steps required to set up the
portal:

LOG IN
Log into the Oria portal with the default Username and Password:

• Username: system
• Password: password

PLAN BUNDLES FORCUSTOMERS
To plan and determine the necessary bundle and feature requirements:

• Identify user types within potential customers and determine requirements for each
user type.
• Design bundles with feature/phone type combinations that will satisfy requirements of
user types you identified in Step 1.

Refer to the following tables for information on bundle features and phone types.

CONSIDERATIONS
• User Bundle phone features are dependent upon the service type and license type
selected for the type of user.
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• Up to three phone types per bundle can be configured, depending upon the service type
and license type selected for the type of user for the bundle.

Note:When you downgrade a user bundle from Oria, for example a user going from 3
phones down to 2, theMiCollab Client API will cause the user's status to be deleted and
recreated. The user will need to log out of MiCollab Client, log in again andmanually
recreate their routing rules (set which devices will ring in different states).
• Phone types and feature profiles are also dependent upon the service type and license
type selected for the type of user (see Table 2, “Phone Types by Service Type,” )
• When selecting UCC user bundles, and creatingMiCollab Client Service users through
Oria, Oria will strip out any domain names from the username field before saving it to
MiCollab. However, the user will receive a welcome email fromMiCollab Client
Service with the login ID to be <username>.<Enterprise domain name>. It will be
necessary to inform MiCollab Client Service users that they need only to log in with
their user ID, not including the domain name.
• WhenMiCollab Client Service users have been created, and after being put in service
there is a subsequent change to a user or a service, that user will receive a logout
request on their MiCollab Client application.
• When aMiCollab Client user changes their credentials in their MiCollab Client, and
subsequently those credentials are changed within Oria, Oria will overwrite the
credentialson theMiCollab Client for that user.
• If a MiCloud Business Multi-Instance user has been created (a SB Entry UCC Bundle)
with Twinning, and the user's firstname, lastname, as well as their email address is
edited via Oria, then their IMAP Account Login in the Voicemail tabmust be changed
manually in the Edit User form in the Oria customer admin portal if the Embedded UM
Enabled option is selected.
• PC MiNet Softphone phone types are programmed on theMiCollab Client MBG.
• When users with MiCloud Business Virtual bundles are created, languages are set by
default based on theMiCollab default language for applications such as MiCollab
Client.
• When users with MiClould Business Mutli-Instance bundles are created, Oria can set
the language for applications such as MiCollab Client because theMiCollab server is
not involved in configuring those applications.
• Modifying a user with a bundle containing the Hot Desk or ACD feature to one with a
non-Hot Desk or non-ACD feature is not permitted. Modifying a user with a bundle
containing a non-Hot Desk or non-ACD feature to one with a Hot Desk or ACD feature
is not permitted. Only changes between non-Hot Desk or non-ACD bundles, as well as
bundles that contain the Hot Desk or ACD features are permitted.
• Users assigned bundles with Mobile Softphone, PC Softphone, Generic SIP, Hotdesk,
or ACD Phone Types will not have their Call History display within their Oria Portal
page.
• Provide access to site administration features on the portal.
• Determine the Class Of Service (COS) numbers that will be used for each Feature
Profile (determine Day/Night1/Night2 service).
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• Record the Feature Profiles with COS numbers and feature combinations for each
Feature Profile.

Note: Part of designing a bundle is to design a Feature Profile that will define the phone
set features that a bundle will provide to the assigned user.
A Feature Profile is essentially registered as a Class of Service (including
Day/Night1/Night2 time of day settings).

Table 1: Supported Phone Sets
PHONE TYPE MODELS

IP 5220, 5304, 5312, 5320, 5320e, 5324, 5330, 5330e, 5340, 5340e,
5360, 5215, 5235, 6920, 6930, 6940

SIP 5603, 5604, 5607, 5610, 5624
Dual Mode 5212, 5220, 5224
DECT 112,
Open Phone 26 27
SIP-DECT 612, 622, 632, 650

Table 2: User Bundle Features by Service and License Type
SERVICE
TYPE

MICLOUD BUSINESS VIRTUAL USER
BUNDLES (MLB)

MICLOUD BUSINESS
MULTI-INSTANCE

FEATURE
BASIC
IPT

STANDARD
IPT

ENTRY
UCC

STANDARD
UCC

PREMIUM
UCC

CONTACT
CENTER
AGENT

BASIC
IPT

STANDARD
IPT

ENTRY
UCC

CONTACT
CENTER
AGENT

Prime Phone Y Y Y Y Y Y Y Y Y Y
Second Phone N N Y Y Y N N N Y N
Third Phone N N Y Y Y N N N Y N
Fourth Phone N N Y Y Y N N N Y N
OPTIONAL
FEATURES
Voicemail N Y Y Y Y Y N Y Y Y
Voicemail to
Email N N N N N N N Y Y Y

Nupoint Class
of Service N Y Y Y Y N N N N N

Message
Waiting N Y Y Y Y N N N N N

Unified
Messaging N N N N N N N N N N

Standard
Unified
Messaging

N N Y Y Y N N N N N

Advanced
Unified
Messaging

N N Y Y Y N N N N N
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AWV
Conferencing N N N N Y N N N N N

MiCollab Client
Service Y Y Y Y Y Y Y Y Y Y

Lync Plugin N N Y Y Y N N N Y N
MiTeam N N N N Y N N N Y N
Next Gen
Mobile SIP
Phone Settings

Y Y Y Y Y Y Y Y Y Y

Enable Secure
Transport Y Y Y Y Y Y Y Y Y Y

Compression Y Y Y Y Y Y Y Y Y Y

Table 3: Phone Types by Service Type - Basic IPT License

SERVICE TYPE MICLOUD BUSINESS VIRTUAL
USER BUNDLE (MLB)

MICLOUD BUSINESS MULTI-
INSTANCE

PHONE TYPE PRIME SECOND THIRD FOURTH PRIME SECOND THIRD FOURTH
Deskphone Y NA NA NA Y NA NA NA
External Phone N NA NA NA N NA NA NA
PC MiNet
Softphone Y NA NA NA Y NA NA NA

PC SIP Softphone Y NA NA NA Y NA NA NA
Mobile SIP
Softphone Y NA NA NA Y NA NA NA

Next GenMobile
SIP Softphone Y NA NA NA Y NA NA NA

Hotdesk Y NA NA NA Y NA NA NA
ACD Y NA NA NA Y NA NA NA
ACD With
Softphone Phone Y NA NA NA Y NA NA NA

Generic SIP Y NA NA NA Y NA NA NA
MiVoice
Conference Phone Y NA NA NA Y N N N

Table 4: Phone Types by Service Type - Standard IPT License

SERVICE TYPE MICLOUD BUSINESS VIRTUAL
USER BUNDLE (MLB)

MICLOUD BUSINESS MULTI-
INSTANCE

PHONE TYPE PRIME SECOND THIRD FOURTH PRIME SECOND THIRD FOURTH
Deskphone Y NA NA NA Y NA NA NA
External Phone N NA NA NA N NA NA NA
PC MiNet
Softphone Y NA NA NA Y NA NA NA

PC SIP Softphone Y NA NA NA Y NA NA NA
Mobile SIP
Softphone Y NA NA NA Y NA NA NA
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Next GenMobile
SIP Softphone Y NA NA NA Y NA NA NA

Hotdesk Y NA NA NA Y NA NA NA
ACD Y NA NA NA Y NA NA NA
ACD With
Softphone Y NA NA NA Y NA NA NA

Generic SIP Y NA NA NA Y NA NA NA
MiVoice
Conference Phone Y N N N Y NA NA NA

Table 5: Phone Types by Service Type - Entry UCC License

SERVICE TYPE MICLOUD BUSINESS VIRTUAL
USER BUNDLE (MLB)

MICLOUD BUSINESS MULTI-
INSTANCE

PHONE TYPE PRIME SECOND THIRD FOURTH PRIME SECOND THIRD FOURTH
Deskphone Y N N N Y N N N
External Phone N Y N N N Y N N
PC MiNet
Softphone Y N Y Y Y Y Y Y

PC SIP Softphone Y N Y Y Y Y Y Y
Mobile SIP
Softphone Y N Y Y Y Y Y Y

Next GenMobile
SIP Softphone Y N Y Y Y Y Y Y

Hotdesk Y N N N Y N N N
ACD N N N N N N N N
ACD With
Softphone N N N N N N N N

Generic SIP Y N Y Y Y Y Y Y
MiVoice
Conference Phone Y N Y Y Y Y Y Y

Table 6: Phone Types by Service Type - Standard UCC License

SERVICE TYPE MICLOUD BUSINESS VIRTUAL
USER BUNDLE (MLB)

MICLOUD BUSINESS MULTI-
INSTANCE

PHONE TYPE PRIME SECOND THIRD FOURTH PRIME SECOND THIRD FOURTH
Deskphone Y N N N NA NA NA NA
External Phone N Y N N NA NA NA NA
PC MiNet
Softphone Y N Y Y NA NA NA NA

PC SIP Softphone Y N Y Y NA NA NA NA
Mobile SIP
Softphone Y N Y Y NA NA NA NA

Next GenMobile
SIP Softphone Y N Y Y NA NA NA NA

Hotdesk Y N N N NA NA NA NA
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ACD N N N N NA NA NA NA
ACD With
Softphone N N N N NA NA NA NA

Generic SIP Y N Y Y NA NA NA NA
MiVoice
Conference Phone Y N Y Y NA NA NA NA

Table 7: Phone Types by Service Type - Premium UCC License

SERVICE TYPE MICLOUD BUSINESS VIRTUAL
USER BUNDLE (MLB)

MICLOUD BUSINESS MULTI-
INSTANCE

PHONE TYPE PRIME SECOND THIRD FOURTH PRIME SECOND THIRD FOURTH
Deskphone Y N N N NA NA NA NA
External Phone N Y N N NA NA NA NA
PC MiNet
Softphone Y N Y Y NA NA NA NA

PC SIP Softphone Y N Y Y NA NA NA NA
Mobile SIP
Softphone Y N Y N NA NA NA NA

Next GenMobile
SIP Softphone Y N Y Y NA NA NA NA

Hotdesk Y N N N NA NA NA NA
ACD N N N N NA NA NA NA
ACD With
Softphone N N N N NA NA NA NA

Generic SIP Y N Y Y NA NA NA NA
MiVoice
Conference Phone Y N Y Y NA NA NA NA

Table 8: Phone Types by Service Type - Contact Center Agent

SERVICE TYPE MICLOUD BUSINESS VIRTUAL
USER BUNDLE (MLB)

MICLOUD BUSINESS MULTI-
INSTANCE

PHONE TYPE PRIME SECOND THIRD FOURTH PRIME SECOND THIRD FOURTH
Deskphone N NA NA NA N NA NA NA
External Phone N NA NA NA N NA NA NA
PC MiNet
Softphone N NA NA NA N NA NA NA

PC SIP Softphone N NA NA NA N NA NA NA
Mobile SIP
Softphone N NA NA NA N NA NA NA

Next GenMobile
SIP Softphone N NA NA NA N NA NA NA

Hotdesk N NA NA NA N NA NA NA
ACD Y NA NA NA Y NA NA NA
ACD With
Softphone Y NA NA NA Y NA NA NA
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Generic SIP N NA NA NA N NA NA NA
MiVoice
Conference Phone N NA NA NA N NA NA NA

Table 9: Oria Administrator Bundle Features
BUNDLE
TYPE FEATURE DESCRIPTION

Administrator
Bundle

ACD
The ACD Group feature allows you to create groups of users that can
be placed in call paths such as those used by call centers and support
groups.

Advanced
Settings Allows the user to modify business hours.

Auto
Attendant Allows the user to create, modify and delete Auto Attendant call flows.

Call Flows Allows the user to create, modify and delete company call flows.

Call Groups Enable user to create, add or remove users to PickupGroups, Hunt
Groups, and RingGroups.

Call
Rerouting
Destinations

Lets the system redirect calls to alternate answering points or devices.

Company
Speed Dial

Enable user to create, modify and delete company wide speed dial
numbers.

Email
Capabilities Enables the user to send information emails and reset passwords.

General
Mailbox

Allows the user to create, modify and delete general company
mailboxes.

Hot Desk
Phones Allows users to create, modify and delete hot desk devices.

Key
Templates Lets youmanage and assign key templates.

Music On
Hold Lets you enable and upload embeddedMusic OnHold (MOH) for a site.

Synchronize
Platforms Lets you initiate the Synchronize Platforms operation for a Customer.

Users Provides access to the directory to create, modify and delete a
customer's users.

CREATE BUNDLES
Bundles are groups of features, phone types, and devices that you assign to one or more
customers. There are two types of Bundles that can be created in Oria:

• Administrator
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• User

Administrator bundles typically provide access to other systemmanagement functions such as
managing Call Groups, Hot Desk Phones, and Key Templates.

User bundles are primarily based on the service and license types you choose. See Planning
Bundles for Customers.htm for details about user bundle services by license type.

USERBUNDLESERVICESANDLICENSETYPES
The services available for user bundles areMyCloud Business Multi-Instance andMiCloud
Business Virtual. EachMiCloud service provides a number of license types to choose from:

MiCloud Business Multi-Instance
• Basic IPT
• Standard IPT
• Entry UCC
• Contact Center Agent

MiCloud Business Virtual
• Basic IPT
• Standard IPT
• Entry UCC
• Standard UCC
• Premium UCC
• Contact Center Agent

Notes:When you downgrade a user bundle from Oria, for example a user going from 3 phones
down to 2, theMiCollab Client API will cause the user's status to be deleted and recreated. The
user will need to logout of MiCollab Client, log in again andmanually recreate their routing rules
(set which devices will ring in different states).
When you change a bundle that includes a teleworker set (registered toMiVoice Business), the
configured ICP on theMBG reverts to the default and the teleworker set logs out. To fix this
issue, manually change the ICP on theMBG back to the configured ICP. TheMAC address is
not affected.

Tomeet the demands of potential customers, design a variety of bundles, and then create them
on the system.

Youmust create at least one user bundle before you or a customer administrator can create a
user.

CREATEUSERBUNDLES

To create a User bundle
1 From theOria system portal, click theBundles tab.

2 Click Create Bundle.
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3 Select User Bundle and click Next.

4 Enter a name, code, and description for the bundle.
Note: If you are deployingMiCollab Clients for Mobile users, you need to create a
special User Bundle of type Next GenMobile SIP Softphone. SeeMiCollab Clients for
Mobile.

5 UnderPhone User Features, select the service and license types for phone users. The
optional features and profiles available will depend on your selections. See Planning Bundles
for Customers for information about the service and license types.

6 Under Select Optional Features, do the following:
• Select the optional features for the service and license type.
• Select the devices to include in the bundle.

7 Click Submit.

8 (optional) Upload any setup instructions that you want to include as an attachment in the
Welcome Email.

9 Click Save.
Notes:
Sometimes failures may occur during a change bundle operation. It is now possible to rollback
the change to its previous configuration. Should a failure occur during a Change Bundle
operation, there will be a series of guided prompts in Oria to either correct the error or revert
back to the previous bundle configuration.
TheOria MiCollab Bundle only enables the AdvancedMiCollab UnifiedMessaging Telephone
User Interface features. Youmust log into Server Manager and open the Nupoint WebConsole
to provision the end user’s Adv. UM Alias, and password (if required).

To create an Administrator bundle
1 From theOria system portal, click theBundles tab.

2 Click Create Bundle.

3 Select Administrator Bundle.

4 Enter a name, code, and description for the bundle.

5 UnderSelect Site Administration Features, assign access permissions for the bundle.

6 Click Submit.

To change a bundle
1 From theOria system portal, click theBundles tab.

2 Select the bundle you want to modify.
Note: The bundles list is grouped based on the initial bundles users were created with (Hotdesk
or non-Hotdesk). If the user was created with a Hotdesk bundle, you cannot change it back to a
non-Hotdesk bundle. The same applies to changing a non-Hotdesk bundle to a Hotdesk bundle.

3 Click theEdit icon.
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4 Make the required changes.
Note: A bundle change does not trigger a resend of theWelcome email. Make sure you resend
theWelcome email manually so that users can receive the updated bundle information.

5 Upload any updated setup instructions that you want to include as an attachment in the
Welcome Email.

6 Click Save.

7 Log out and log back into Oria to enable your changes.

MICOLLABCLIENTSFORMOBILE
If you are deployingMiCollab Clients for mobile users, you need to create a special User Bundle
of type Next GenMobile SIP Softphone.

When you assign a Next GenMobile SIP Phone for MiCollab Client, make sure that you add text
in theWelcome email to notify users that they will receive an additional email with instructions on
how to deploy the Next GenMobile Phone application. For instructions on how to set upMiCollab
Client for Mobile users, seeOptional: PrepareMiCollab Client for mobile users in theMiCloud
Business for Service Providers Deployment Guide.

Important: If users are receiving theWelcome email but not the Deployment email, make sure
that theMiCollab server is able to contact the redirect server. Look in theMiCollab server logs
for the error "Could not connect to Server... Network is unreachable".

Here is an example of a deployment email sent to a user:

Deployment Email for MiCollab for Mobile Application
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UPLOADBUNDLESETUP INSTRUCTIONS
When you create a bundle, you can choose to upload setup instructions for users. The
instructions are sent as an attachment in theWelcome email and alsomade available (download)
in the user portal My Services page. All documents file formats are supported and there are no file
size restrictions.
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REGISTERDIALING PRIVILEGES
Dialing Privileges correspond to Class of Restriction (COR) numbers that have been pre-
configured to specific Automatic Route Selection (ARS) routes programmed on the default
MiVoice Business database.

As a recommended guideline:

• Create and pre-configure all required Dialing Privileges on the default MiVoice
Business database prior to customer creation.
• Design the Dialing Privileges based on predictions of where calls will come from and
what type of outbound calling privileges will be required.
• Configure the Dialing Privileges to be the same on every MiVoice Business Platform
that is managed using Oria. The goal is to create a shared set of dialing privileges that
can be assigned to any customer provisioned using Oria and allow each customer to
access the same routes. Due to this requirement, a Default MiVoice Business Platform
Databasemust be created to include ARS programming that can be set for all MiVoice
Business Platform instances.

To plan and determine the necessary dialing privilege requirements:
1 Determine cities, states/provinces, and countries in which service will be provided.

2 Gather all dialling patterns (local, long distance, international, etc.) that will be offered.

3 Determine all required Dialing Privileges to satisfy customer needs. (Capturing this information
in a spreadsheet will make it easier to enter the information in Oria.)

4 Ensure design has been completed properly for default MiVoice Business Platform data- base
configuration.

To register Dialing Privileges:
1 Log in to Oria.

2 Click the Telephony tab and select Dialing Privileges.

3 Click Register Dialing Privilege.

SET UP PHONE KEYS
You can set up phone keys and default Key Templates from within the service provider portal and
assign them to a customer during customer creation. After a template is assigned, changes
made to it from the service provider portal are not applied to the template viewed by the Customer
Administrator. The Customer Administrator sees the template as it was initially configured.

CREATEKEYTEMPLATES



Create Brands

37

Service Providers can create Key Templates for Customer Administrators to use when setting up
users instead of programming the keys manually.

Important: The programming of SIP DECT Phone Set keys is not supported in the Customer
Administrator Portal.

To create a Key Template:
1 From the Telephony tab, click Key Templates, then click Create Template.

2 (optional) In Phone Layout, select the phone layout to display. Leaving the setting at default
displays all the possible phone keys.

3 Program each key by clicking it and setting the features. You can also apply the template to
users who have one row of keys.

4 Click Save.

CREATE BRANDS
Color schemes and images displayed throughout the portal can be created andmodified tomatch
a corporate brand or other desired customized brand. Multiple brands can be created on the
system, which allows different service provider customers to have different portal branding
schemes assigned to them.

The followingmodifiable branding options are available:

• Company Logo
• Login Page Image
• Portal Banner Image

a Favicon Image (Browser Tab)

• Navigation Bar Color
• Heading & Page Link Color

Use the brand creation wizard to create a customized brand that can be assigned to one or more
customers. Users will see the images and colors associated with the brand assigned to their
company while logged into the portal. When a change is made to a brand it is reflected across the
system and any customers that were assigned the initial brand will see the changes when they
log into the portal.

To create a Corporate Brand:
1 Collect the following information:

• URL for the following company pages:
• Company Website
• Terms of Use Page
• Privacy Policy Page

2 Image of the corporate logo:
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• Recommended Dimensions: 60 pixels (height)
• Supported Formats: JPG / GIF / PNG

3 Design and create the following corporate images:

b Login page

• Recommended Dimensions: 575 pixels X 230 pixels
• Supported Formats: JPG / GIF / PNG

c Portal banner

• Recommended Dimensions: 950 pixels X 150 pixels
• Supported Formats: JPG / GIF / PNG

d Favicon (browser tab)

• Recommended Dimensions: 17 pixels X 17 pixels
• Supported Formats: ICO. An error message appears when the image is not in the correct
format.

4 Determine color scheme for navigation bar and headings / page links. Color Code: HEX / RGB
/ HSB

5 Log in to Oria, click the System tab, select Brands, then click Create Brand.

CREATE THEWELCOME EMAIL
AWelcome Email is the email message that new users receive when their account is created.
Typically aWelcome Email contains welcome text and user login credentials. TheWelcome
Email is derived from the default email template through customization. A service provider
creates and edits email templates in System > Email Template.

Oria displays theWelcome Email in the receiver's language as long as that language is
supported.

Important: If you need to stopWelcome Email messages from being sent fromMiCollab, you
must disable the option fromMiCollab (after upgrading to Oria 5.3).

The following flowcharts outline the steps required for setting up and generating theWelcome
Email:
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Figure 1: Register Platform Group and Setup Email Server
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Figure 2: Create Bundle and Email Template

Figure 3: User Creation and Welcome Email
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You can send aWelcome Email manually by selecting the user and then selecting the "Send
Welcome Email" action. Or youmay prefer to send theWelcome Email automatically to all users
when they are created. Bulk Import supports the automatic sending of theWelcome Email on
user creation. When users are added using Bulk Imports theWelcome Email is automatically
sent to each user. Oria provides a default email template with pre-populated content and all
services enabled for both new installs and product upgrades. You cannot delete the default email
template.

Any setup instructions that you upload are sent with theWelcome Email and they are also
accessible from the user’s My Services page.

A Welcome Email can contain the following types of information:

• Customized content
• List of services the user has access to
• User name and password
• Links to services
• Links to application downloads

LANGUAGESUPPORT
The Subject, Greeting, and Footer text fields all support international text (UTF-8).

DEFAULTEMAIL TEMPLATECONTENTANDOPTIONS
The default Email template contains editable pre-populated content and has all options enabled:

• Sender’s email address in the format donotreply@<OriaPublicFQDN>.com. The
service provider can change the sender’s email address if required.
• Greeting text.
• Footer text.
• Subject text: "Welcome to the User Portal," <lastname, firstname of the user as a
suffix>

Note: The Subject field supports plain text only.
• All the options are selected for the email and portal.
• Branding in the email is picked up from the service provider’s branding. The banner
image is used in HTML email messages.

ASSIGNING EMAIL PERMISSIONS
A service provider must assign customer administrators the Email capability in the Admin Bundle
to allow them to resend theWelcome Email, reset passwords, and preview email messages. The
automatic sending of theWelcome Email on user creation is always set by the service provider.

EMAIL TEMPLATEPERMISSIONS
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The email capability in Admin Bundle is required to let the Customer Admin sendWelcome
Emails, Reset passwords and Preview Emails. If a customer is not assigned with a bundle with
the email capability, only the service provider can "login as" a customer administrator to resend
Welcome Emails or reset passwords. The customer administrator will not see those actions.

However, enabling or disabling the email capability from the Admin bunde does not affect the
automatic sending of Welcome Emails on user creation. The automatic sending of theWelcome
Email is governed by a checkbox in the add/edit cutomer page.

Here is a summary of the permissions granted for email templates andmessages:

• Email template privileges aremanaged throughOperations profiles.
• Only the service provider can create email templates.
• A service provider should not include the email capability in the Admin Bundle assign to
a customer if the permission to send email messages is not wanted.
• A service provider configures whetherWelcome Email messages are automatically
sent when a user is created. This will be done while creating the customer.
• A customer can sendWelcome Email messages only when theWelcome Email
template is assigned to them by a service provider.
• A customer can resend aWelcome Email or reset a password when assigned a bundle
with those rights.
• With email rights, a customer can upload instructions when configuring the email
template.

The instructions are sent with the email and also appear in theMy Services page.

CUSTOMIZE THEWELCOME EMAIL CONTENT
You can customize the information in theWelcome Email and have it automatically sent when a
customer adds a new user to the portal. Service providers assign email templates to Customers
during Customer creation. Customers can then use the templates to send automatic email
messages with relevant information. For example, sending a reminder email message when a
password is reset.

Access to theWelcome Email feature is granted through:

• Any operations profile with the permission to create customers has access to the
Welcome Email feature.
• All the Admin bundles that allow you the creation of users has access theWelcome
Email feature.

To customize the Welcome Email:
1 Configure the username in the subject of the email and choose whether the name a suffix or a

prefix.

2 Add a custom header and footer. Headers and footers can contain HTML content.
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3 Customize the email message as required. Youmay want to include a note for users who have
Next GenMobile SIP Phones that they will receive an email with instructions on how to install
theMiCollab for Mobile application.

4 Choose the options to include in the email for the user, for example the user name, pass- word,
links to application downloads and so on. Only the selected option appear in the email
message or the services page.

5 (optional) Upload setup instructions that you want to send as an attachment.

To preview the Welcome Email
1 Click Customer > View Customers.

2 Select the Customer and click the Log in as Customer icon.

3 From the Customer Administrator portal, click theUsers and select the user.

4 Click More > Preview Email.

To resend the Welcome Email
1 Click Customer > View Customers.

2 Select the Customer and click the Log in as Customer icon.

3 From the Customer Administrator portal, click theUsers and select one or more users.

4 Click More > Resend Welcome Email.

To reset the password
1 Click Customer > View Customers.

2 Select the Customer and click the Log in as Customer icon.

3 From the Customer Administrator portal, click theUsers and select one or more users.

4 Click More > Reset Passcode.

CREATE EMAIL TEMPLATES
A service provider or anyone with email template privileges can create and configure email
templates for customers. Customers then use the templates to send email messages with
specific information in them to one or more customers. For example, an email message that
reminds users to change their password.

To create an email template
1 From theSystem tab click Email Template and then click Create Email Template.

2 Enter the email template details and select the content to include in the email message.
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SET UP MICOLLAB CLIENTS

MICOLLAB CLIENTS FORMOBILE
If you are deployingMiCollab Clients for mobile users, you need to create a special User Bundle
of type Next GenMobile SIP Softphone.

When you assign a Next GenMobile SIP Phone for MiCollab Client, make sure that you add text
in theWelcome Email to notify users that they will receive an additional email with instructions
on how to deploy the Next GenMobile Phone application. For instructions on how to set up
MiCollab Client for Mobile users, seeOptional: PrepareMiCollab Client for mobile users in the
MiCloud Business for Service Providers Deployment Guide.

Important: If users are receiving theWelcome Email but not the Deployment email, make sure
that theMiCollab server is able to contact the redirect server. Look in theMiCollab server logs
for the error "Could not connect to Server... Network is unreachable".

Here is an example of a deployment email sent to a user:

Deployment Email for MiCollab for Mobile Application
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MICOLLABMACCLIENTS
If you are deployingMiCollabMAC Clients, youmust enableMAC Client support in Oria and
create a user bundle that includes a PC SIP Softphone for aMAC Desktop Client or a Next Gen
Mobile Client Softphone phone for aMobile Client.

After you enableMiCollabMAC Client, make sure that you either attach a file with deployment
instructions (see Deployment Email Template below) to theWelcome Email or go toMiCollab
Client Deployment and customize theMiCollab Deployment email.

Deployment Email Template

Here is a recommended template to use for theMAC Clients deployment email:

Dear [####firstname####] [####lastname####],



Installation and Administration Guide

46

You received this e-mail because your Mitel MiCollab administrator has started the deployment
process for your Mitel MiCollab Client for extension number [####dn####].

Please first refer to yourWelcome E-mail to determine if extension number [####dn####] is a
Mobile Client or aMAC Desktop Client. The extension will have a "Next GenMobile Client
Softphone" phone type for aMobile Client and a phone type of "PC SIP Softphone" for aMAC
Desktop Client.

For installation of the client, please use the App Store for your device.

[####appstore####][####playstore####][####microsoftstore####][####bbworld####]
[####appstore_mac####]

If you are reading this on your mobile phone, PC orMAC, and you have downloaded and installed
theMiCollab for Mobile Application, then please use the following direct link to start the
deployment process: [####link####]

If you are reading this e-mail on your PC orMAC, or your administrator printed the E-mail, and
you have downloaded and installed theMiCollab for Mobile application, use aQR-code reader
application on your mobile phone to scan theQR-code below.

You can also start the deployment process by launching theMiCollab Client application on your
phone or MAC. The client will request to enter the authentication key.

Please use the following key: [####authtoken####]

NOTE: This is an automatic e-mail notification. Please do not reply to this email. Replies will not
be read.

[####qrcode####]

PROVISION AWEBRTCMICOLLABWEB CLIENT
WebRTC provides a web-based softphone that you access from a browser. The softphone
supports audio calls using your PC microphone and speakers or USB headset.

To provision a WebRTC MiCollab Web Client:

The user will receive a deployment email with their MiCollabWebClient URL and a username.
The user's password is sent in another email and the user can access MiCollabWebClient.

• Create a user that has a PC SIP Softphone in the bundle.
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Important: Only Chrome and Firefox are supported for theWebRTC MiCollabWebClient.

BULK IMPORT USERS
Download the import spreadsheet for the customer, fill it in, and import the changes back into the
portal. After filing in the information, import the spreadsheet back into the portal. It is best
practice to import the spreadsheet back into the portal beforemaking changes to customer
MiVoice Business platforms, dialing privileges, bundles, or feature profiles. Themaximum
number of users you can delete at one time is 200.

If you have an Active Directory file, you canmerge the .ldif file into the Oria Bulk Import
workflow. See Associate Active Directory Fields with Bulk Import Fields.

To bulk import users:
1 From theCustomers tab, click Bulk Import.

2 Click Import Users.

3 In Step 1: Get Import File, select the customer to which you want to add the users.

4 Fill the required fields by following the instructions in the import spreadsheet.

5 In Step 2: Select Import FileClick Browse, select the updated spreadsheet.

6 Click Submit. To ensure the import runs smoothly, most of the portal locks during the import.
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ADVANCED SETTINGS
Advanced settings allow you to configure Key Permissions, Auto Attendant, Ranges, and Call
Flow options.

KEY PERMISSIONS
Set key permission to allow users to create and edit key templates and program phone keys.

To set key permissions:
1 From theSystems tab, click Advanced.

2 Click theKey Permissions tab.

3 Select the key permissions for these users; Service Provider (SP), Reseller (RS), Customer
Administrator (CA) and End User (EU). By default, all keys are available to administrator level
users.

4 Click Save.

AUTO ATTENDANT
Auto Attendant settings display when the platform group type is MiVoice Business. For MiCollab
andMiVoice Business Express, only the Voicemail Hunt Group Pilot Number field is displayed.
You can program the following settings:

Voicemail Hunt Group Pilot Number: Program the Voicemail Hunt Group Pilot Number. For
example: 6000.

Bilingual Options for Auto Attendant: Enable or disable the bilingual option for Auto Attendant
and program the bilingual Key Number. For example: 8.

Default passcode for Auto Attendant Mailboxes: Program the default passcode for Auto
Attendant mailboxes. For example: 1111.

Supervised Transfer for Auto Attendant: Enable or disable Supervised Transfer for the Auto
Attendant and program the Ringback Timeout. For example: 17 seconds. For more information,
seeSystem Applications > Messaging > VoiceMail (Embedded) > Programming > Setting the
Auto Attendant Transfer Type in theMiVoice Business System Administration Tool Help.

To program Auto Attendant settings:
1 From theSystems tab, click Advanced.

2 Click theAuto Attendant tab.

3 Enable, disable, and program the Auto Attendant settings.

4 Click Save.

RANGES
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Lets you specify the lower and upper ranges for creating Speed Dials, generating Auto Attendant
andGeneral mailboxes, and generating directory numbers for Call Flows.

To program upper and lower ranges:
1 From theSystems tab, click Advanced.

2 Click theRanges tab.

3 Program the ranges for Speed Dials, Auto Attendant andGeneral mailboxes, and directory
numbers for Call Flows.

4 Click Save.

CALL FLOW
Lets you specify default Call Flow settings:

Feature Access Codes: Program the Feature Access Codes the system will use for Call Flows:

• MessageWaiting - Activate
• MessageWaiting - Deactivate
• Dialed Day/Night Service - Activate
• Call Forward - Follow Me - Third Party

Default Key Starting Position: Program the default phone key starting positions for users'
phones.

• Key line appearance
• MessageWaiting Indicator
• Day/Night Service activation

To specify default Call Flow settings:
1 From theSystems tab, click Advanced.

2 Click theCall Flow tab.

3 Program the Feature Access codes and default key starting positions.

Note: Key starting positions apply when the user's prime phone is a Desktop phone. It does not
apply to Hotdesk or ACD users. The Hotdesk/Hotdesk user's key starting position follows the
16 key phone.

4 Click Save.
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SET UP CUSTOMERS
CAUTION: Youmust create and provision users before connecting those users’ phones.
If not, you will receive an error in indicating that the devices already exist on theMBG and
cannot be assigned to those users.

Oria provides customers with access to the Customer Administrator self-service web portal to
perform the following specific site administration operations:

• Add and delete users
• Create customized device key templates for users
• Configure call groups (hunt, ring, and pickup)
• Setup group voicemail box
• Add and delete groups
• Create company-wide system speedcall numbers

Additionally, users have access to a variety of phone features defined by their assigned bundle.
Oria enables the service provider to offer a self-service web portal where end users can perform
the following tasks:

• Check missed calls even when away from their desk (applies to desktop phones only)
• Customize their phone and setupmultiple speed dial keys
• Quickly search the company directory for contact details
• Change their voicemail passcode
• Configure their twinning settings, for example a phone and cell phone

Ensure that all collected customer and business requirements have been implemented in the
portal. To provide a customer access to Oria, youmust provide the unique URL of the customer
portal. If the customer is given full site administration privileges, send the customer the
administrator the primary account username and password.

SET UP PLATFORMGROUPS
UseOria to assign one or more platform groups to a customer. Tomake a platform group
available to a customer, register it and set it up as a site in a resilient or non-resilient environment.
After setting up a site, you can set upMiCollab Client Multi-Tenant servers.

Enter a public facing domain name for each platform group you register so that users can access
Mitel platforms and theOria portal. Public facing fully qualified domain names (FQDN) are used
to construct URLs. An FQDN is required for the following products:

• MiVoice Business Express
• MiCollab
• Mitel Border Gateway

REGISTERAPLATFORMGROUP
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Registering a platform group with the portal allows you to assign it to a customer. Register a
platform group with oneMiVoice Business or with multiple resilient pairs. For eachMyVoice
Business pair, youmust configure cluster elements in ESM.

Important:When registering a platform group in Oria, the IP or FQDN entered for the hostname
appears as the public facing domain name. You can choose to leave the default name or
change it. The setting is available in the Advanced Settings page. Only a service provider can
change the settings.

To register a platform group:
1 Select Platforms > Platform Groups and then click Register Platform.

Note: Click Save to save the changes in the current tab beforemoving on to the next tab.

2 Select the platform type from the Type list.
Notes: It is important to enter theMSLUsername and Password in the appropriated
fields when registering aMiCollab or MiCollab with Voice platform group. Otherwise, the
registration will fail.
Whenmigrating fromMiCollab 5.0 SP2 toMiCollab 6.0 SP1, you need to re-enter the
MSLUsername and Password credentials when performing edit operations (such as
when editing a platform group).

3 Click Submit to register the platform group.

4 Add theMiVoice Business instance(s).

5 Add Sites as necessary to associate with the platform group.

Note:When creating (or subsequently modifying) Sites and configuring the associated
MBG(s), the User Phone Details will show up to four user phones that can be
programmed on theMBG. Both theMiCloud Business Multi Instance andMiCloud
Business Virtual Entry UCC Bundle has four phones associated with it. See Planning
Bundles for the phone types supported for each license type. To ensure that the user’s
SIP phone number is programmed on theMBG, verify that the Third Phone check box is
selected. To ensure that the user’s SIP phone number is programmed on theMBG, verify
that the Third Phone check box is selected.

6 AddMiCollab Client Tenants as necessary. To enableMiCollabMiTeam, click MiTeam
Service.

MICOLLAB CLIENTS FORMULTIPLE TENANTS
Oria allows a Service Provider to set upMiCollab Clients for multiple Customers on the same
MiCollab Client server. The Tenants configured in Oria on the sameMiCollab Client server
appear as a unique Enterprises per Tenant.

Terminology: Note that on theMiCollab Client Server, we use the term Enterprises. OnOria we
use the term Tenants. When you create users, they are grouped into their corresponding
Tenant/Enterprise.
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When the platform group is registered with aMiCollab Client Tenant, Oria creates an appropriate
Enterprise on theMiCollab Client server.

Note: After you configureMiCollab throughOria, changes should not bemade on theMiCollab
Client server; this will cause configuration issues and possible loss of MiCollab Client services.

There are some limitations and restrictions for MiCollab Clients (e.g. Calendar integrations).
Refer to theMiCollab Client Administrator Guide and theMiCollab Client AdministratorWebHelp
for more information (go to http://edocs.mitel.com).

Synchronizing Platforms WhenUsingMiCollabMulti-Tenant

A new user created inMiVoice Business does not appear in MiCollab until a synchronization
betweenMiCollabMulti-Tenant andMiVB takes place, which by default is every 24 hours. To
synchronize platforms at anytime, use theSynchronize Platforms button in the Customer
Administrator portal:

• Click Company and then select Advanced>Synchronize Platforms.

ENABLEMICOLLABMITEAM
MiCollabMiTeam is amobile-first on-demand collaboration tool. It provides a persistent
workspace for team collaboration with messaging, content sharing, white boarding, and real-time
voice and videomeetings, allowing teams to communicate in real time nomatter where they are.

MiCollabMiTeam is available with Entry UCC based Service Bundles in the SMB architecture
and is available with Premium UCC Service Bundles in theMLB architecture. See Planning
Bundles for Customers.

To enable MiCollab MiTeam
1 Register the platform group.

2 Click theMiCollab Client Tenant tab.

3 Select MiTeam Services.

4 Click Save.

SET THEMICOLLABMITEAM DATA CENTER
LOCATION

You can set the location of theMiCollabMiTeam data center in the Service Provider Portal to
support Data Sovereignty requirements. Oria 5.3 with MiCloud Business 3.3 supports three
locations for hostingMiTeam user data; US (default), Europe, and China.

If you have users that reside in both the Europe and the US, set the data center location to EU.
The laws in the US allow data storage in Europe.

Note: If you upgraded to Oria 5.3 but are usingMiCloud Business 3.2 or earlier, theMiTeam
data center location is set to US by default and is read-only (grayed out). The data location
setting was not available in MiCloud Business 3.2 and earlier or MiCollab versions earlier than
7.3.
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To set the MiTeam data center location
1 Go to Platforms > Platform Groups, select the platform group, and then click theEdit icon.

2 Click theMiCollab Client Tenant tab.

3 From theMiTeam Data Center Location list, select the new location.

4 Click Save.

CREATE A PLATFORMGROUP USING A BLUEPRINT
Platform Manager provides a way for Service Providers to createMiVoice Business platform
groups based on blueprints created with Platform Manager.

Important: If youmake a change to the Platform Manager server, for example change the
credentials, make sure that you also change them in Oria.

To use Platform Manager blueprints in Oria, follow these steps:

1 Enable the Platform Manager feature.

2 Register Platform Manager.

3 Register a Platform Manager blueprint.

4 Create platform groups using a Platform Manager blueprint.

Note: Blueprints apply to MiVoice Business type platform groups only.

ENABLETHEPLATFORMMANAGERFEATURE
1 From theSystem tab, click Operations Profile.

2 Do one of the following:

a To create a new profile and enable Platform Manager, click Create Operations
Profile, select Platform Managed and other features and responsibilities to include in
the profile.

b Select the profile, click the Edit icon, and select Platform Managed.

3 Click Submit.

REGISTERPLATFORMMANAGER
1 From theSystem tab, click Platform Manager Registration.

2 Do all for the following:

a In theHost Name field, enter the Platform Manager IP address or FQDN.

b In the Username andPassword fields, enter theMSL Admin username and
password.

c In thePassword Token field, enter the token for establishing a trusted relationship
betweenOria and the Platform Manager.

3 Click Submit.
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Update a Registered Platform Manager server

You canmodify all the settings after you register a Platform Manager server. If the IP address
now points to a different Platform Manager server, make sure that you restore a backup from the
original Platform Manager server.

Important: Pointing to a completely different Platform Manager server can result in
unpredictable results.

Delete a Registered Platform Manager server

You can delete a registered Platform Manager server if no platform groups are configured on it.
Deleting the Platform Manager server also deletes all the configured Platform Manager
blueprints.

REGISTERAPLATFORMMANAGERBLUEPRINT
Register a Platform Manager blueprint configured in Platform Manager so that you can
automatically generate base platform instances during Customer provisioning.

To register a Platform Manager blueprint
1 From the Platforms tab, click Platform Manager Blueprints Assignment.

2 Click Register Platform Manager Blueprint.

3 Enter a unique andmeaningful name for the blueprint.

4 Select the Platform Manager blueprint to register.

5 Enter a description for the blueprint, including the specific platform features that are included.
Some special characters [/, <, >, :, etc] are not supported.

6 Click Submit.

Edit Platform Manager blueprints

You can change the Name, Description and Deprecated fields anytime after creating a blueprint.
However, after you use a Platform Manager blueprint to create a platform group, you cannot
change it. If you delete the platform(s) that use the blueprint, you can edit the blueprint again.

Delete Platform Manager blueprints

Similar to the Edit operation, you cannot delete a blueprint that was used to create a platform
group. If you delete the platform(s) that use the blueprint, you can delete the blueprint.

Deprecate a Platform Manager blueprint

You can deprecate a Platform Manager blueprint so that it can no longer be used to create
platform groups. A blueprint that is marked as "Deprecated", does not affect any existing
platform groups created with the blueprint.

CREATEAPLATFORMGROUPUSING ABLUEPRINT
Create as many platform groups as you need using a blueprint.
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Important: After you create a platform group using a blueprint, you cannot add any more
MiVoice Business instances to that group.

1 Click the Platforms tab, select Platform Groups, then click Register Platform.

Notes:When registering a Platform, click Savewhenworking in each of the tabs
associated with the task at hand, beforemoving on to the next tab.
When registering a platform in Oria, the IP or FQDN entered for the hostname appears as
the public facing domain name. You can choose to leave the default name or change it.
The setting is available in the Advanced Settings page. Only a service provider can
change Advanced settings.

2 SelectMiVoice Business from the Type drop-down list. Blueprints apply to MiVoice Business
type platform groups only.

3 SelectManaged Platform.

4 From theBlueprints list, select the blueprint to use to create the platform group.

5 Click Submit to register the platform group.

CONFIGUREORIA IN A NAT NETWORK
NAT-based networks are required for MiCollab Platform-based solutions in MLBs.

Note: Although theMiCollab Platform based solution includes MiVoice Business nodes there is
no NAT support for theMiVoice Business only Platform solution.

For Oria to access nodes (for example, MiVoice Business) from the SP Network, two IP
addresses are required:

• Customer Host Name - the IP address configured on the node itself (for example
MiVoice Business).
• Management Host Name - the IP address needed to access nodes (for example
MiVoice Business) from the Service Provider network.

Step 1 Register the MiCollab platform with NAT support
1 Click the Platforms tab, select Platform Groups, then click Register Platform.
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2 Select Configure Management Host Names For This Platform. This information tells Oria
that theMiCollab is deployed in a NAT network.

Note: You cannot disable the Requires Management Host NameConfiguration after you
register theMiCollab platform.

3 Enter the required information.
Important: Make sure you enter theManagement Host Name IP address in the Host Name
field. TheManagement Host Name IP address is used to access MiCollab from the Service
Provide network and is not the actual IP Address (or FQDN) of theMiCollab on the Customer
Network. The Public Facing FQDN/IP Address field is independent and has no effect on this
configuration.

4 Click Submit

Step 2 Configure the MiVoice Business node with the Management Host Name
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After MiCollab is registered, theMiVoice Business tab lists any MiVoice Business nodes that
you add toMiCollab. By default MiVoice Business displays its own IP Address as configured in
the Customer Network (the Customer Host Name field). Use the following procedure to configure
theManagement Host Name so that Oria can access theMiVoice Business from the Service
Provider network.

1 Click theMiVoice Business tab.

2 Click theEdit button for the first MiVoice Business listed.

3 In theManagement Host Name field, enter the IP Address that is used to access MiVoice
Business from the Service Provide network.

4 Click Save.

5 If required, configure other MiVoice Business instances.

Step 3 Complete the MiCollab registration

All tabs except for Platform Details andMiVoice Business are disabled until you enter the
Management Host Name in Step 2.

1 Use the tabs to configure Sites, SIP Billing Number, and other platform group settings.

2 Click Save.



Reconfigure MiCollab to enable NAT support

58

3 See theMigrate toMiCloud 3.1 Flow Through Provisioning section inUpgrade theOria
Software if you upgraded fromMiCloud Business 2.0 toMiCloud Business 3.1.

RECONFIGUREMICOLLAB TO ENABLE NAT
SUPPORT

If you previously registeredMiCollab without NAT support, you can enable it using the following
steps.

To reconfigure MiCollab to enable NAT support
1 Click Platforms and then click the Edit icon for theMiCollab platform.

2 From the Platform Details tab, enable the “Requires Management Host NameConfiguration”.

ConfigureMiVoice Business node with Management Host Name

1 Select the “MiVoice Business” tab. TheMiVoice Business nodes are listed with defaulted
“Management Host Name” values. The “Management Host Name” is defaulted to the “Local
Host Name” (which is the IP Address/FQDN of theMiVoice Business in the Customer
network).

2 Click on the Edit button on the first MiVoice Business instance. This will bring up a dialog to
enter the “Management Host Name”. Remove the defaulted “Management Host Name” IP
Address, and enter the IP Address that is used to access theMiVoice Business from the
Service Provide network and click Save.

3 Repeat this process as needed for all the listedMiVoice Business instances.
Notes: A MiCollab registered with “Requires Management Host NameConfiguration”
cannot be reconfigured to disable NAT support. This MiCollab needs to be deleted and
re-added.
See theMigrate toMiCloud 3.1 Flow Through Provisioning section inUpgrade theOria
Software if you upgraded fromMiCloud Business 2.0 toMiCloud Business 3.1.

EXTEND THE NUMBEROF AGENT SKILL GROUPS
AVAILABLE IN THE ORIA PORTAL

Each instance of MiVoice Business in Oria can have amaximum of 999 Agent Skill Groups.
However, in the Oria portal, call flows use Agent Skill Groups with ACD Paths and by default the
Multi-Instance Communications Director (MICD) configuration limits the number of Agent Skill
Groups to 64. You can increase this limit by changing the Extended Agent Skill Group setting
in the License and Option Selection form.

CREATE CUSTOMERS
Before you can create a customer, youmust have registered a platform group for the customer
and configured the bundles intended for sale. Once those are in place, you can create the
customer from the Customers tab. When creating a customer, make sure you have the first
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customer user's information, the customer's Calling Party Numbers (CPNs) and, if necessary,
the customer's CESIDs that are available.

Ensure that all collected customer and business requirements have been implemented in the
portal. To provide a customer access to Oria, youmust provide the unique URL of the customer
portal. If the customer is given full site administration privileges, send the customer the
administrator the primary account username and password.

CUSTOMERADMINISTRATORTASKSANDPERFORMANCE
A customer administrator can carry out simple tasks that do not rely on referenced records while
new background tasks are pending (asynchronous). More complex tasks that rely on referenced
records (for example general mailboxes) may need to complete before starting new tasks that
reference the current background task.

Important: If you choose an extension length of 7 for a customer and then create a bundle with
two or more phones, the customer will not be able to create a user with that bundle.

To create a customer:
1 From theCustomers tab, click View Customers.

2 Click Create Customer.

3 Enter the following information:

a Customer Information

• Enter customer details.
• Select the customer's time zone.
• Select portal branding.

b Platform Assignment

• Assign a platform to the customer.

c Extension Length

• Select the extension length for phones.

d Dialing Privilege Assignment

• Select dialing privileges.

e Key Templates

• Add or remove phone key templates.

f Email Template Assignment

• Select the default email template for the customer.

g Billing Change Notification (optional)

• Click the check box to enable Billing Change Notification.

h Time Zone
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• Select the default time zone for the customer.

i CPN Substitution

• Enter the caller ID information that will appear on the called party's phone.

j Emergency Details

• Enter the emergency site name, number and default emergency information.

k Bundle Assignment

• Enter the quantity of each type of bundle to assign to the customer.

l Hotdesk Devices

• Select one or more hotdesk devices to add as options for this customer.

m Primary Administrator of Customer

• Select Language - Select a language preference for the customer's end user portal.
• Personal Details - Enter the Administrator's name and email address.
• Login Details - Enter the Administrator's username and password.
• Bundle Assignment - Select a bundle for the Administrator.

4 Click Submit.

ADDORREMOVEDIDRANGES
A Direct Inward Dialing (DID) number is the number dialed from a public network through a trunk
line to a site's PBX and then to a user's phone. It provides an individual phone number per person
in a company by allowingmultiple lines to be connected to the PBX all at once without requiring
each to have a physical line connecting to the PBX.

To add DID ranges
1 From theCustomers tab, click View Customers.

2 Select the customer and click theEdit icon.

3 Click the DID Ranges tab.

4 Do any of the following:

a To add a DID or DID range, enter the Range Start and Range End value and click the
+ sign.

b To remove a DID or DID range, enter the Range Start and Range End value and click
the - sign or click theX next to the range you want to remove.

5 Click Save.

To assign a platform group to a customer:
1 Create a new customer and assign a Platform Group using the Create Customer wizard.

2 Create a new user for the customer and assign a Site using the Create User wizard.
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Note: Oria prohibits the creation of duplicate SIP usernames. Do not create users with
duplicate SIP user names for multiple customers that share the sameMBG. You will get
an error when you try to create the second one with the same SIP.
• Whenmodifying a Customer that requires a connection to theMiCollab Server, and if the
connection to the Platform Group fails for any reason and an error message displays or if
the rollback fails, carry out the following and re-try the edit operation again:
• Check the network connection
• Ping the Platform to ensure it is reachable
• Try editing another Customer (if applicable) to see if the same error occurs. A live
network connection is to MAS andMCD is required to create a platform.

MAP ACTIVE DIRECTORY FIELDSWITH BULK IMPORT
FIELDS

A Service Provider can now merge an .ldif file into the Oria Bulk Import workflow. Active
Directory Association uses existing fields in Active Directory (AD) and allows you to re-use them
tomap to specific fields in the Oria Bulk Import or add custom fields into an AD schema.

Considerations

Keep these points in mind that AD:

• is only accessible when a Service Provider performs a Log in as Customer.
• only imports .ldif files created from AD.
• Administrators can only upload and work with one “.ldif” file at a time.
• Administrators must know and understand the attributes in an ldif file in order to
perform themappings.

Here are the steps required to associate AD with the Oria Bulk Import:

1 Log in to access Active Directory Association.

2 Upload .ldif files.

3 Map the fields.

4 Assign bundles to users.

5 Import the changes back into the portal

STEP 1 LOG INACTIVEDIRECTORYASSOCIATION
1 From the Service Provider Portal select Customers > View Customers.

2 Select the customer and then click the Login as customer administrator icon.
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3 From the Customer Administrator Portal, select Advanced > Active Directory Association.

STEP 2UPLOADLDIF FILES
4 After you select Active Directory Association, you are taken to theActive Directory

Association page.

5 Click Add New. The New Active Directory Association upload dialog box appears.

6 Click the folder icon to upload the .ldif file. After you select the file, it appears in the dialog box.
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7 Click Save.

8 The uploaded file displays the following information:
• The number of users that have been Bulk Imported into Oria.
• The number of users that have bundles assigned to them.
• The total number of users in the .ldif file.

9 Select and click the file to open it. If you want to delete the uploaded file, select the file and
then click Delete.

STEP 3MAPTHEFIELDS
Take the following information into consideration before performing the field mappings between
Oria and AD. Tomap theOria field names (see below) between AD to Oria, the same valuemust
reside onOria. Themore fields you canmap the less work is needed in the Bulk Import
Spreadsheet.

Oria Field Names
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Site, Dialing Privileges, DID, Prime Phone CPN, Prime Phone Key Template, Prime Phone
Device Type, Prime Phone Emergency Location, Second Phone Emergency Location, Third
Phone Emergency Location, Fourth Phone Emergency Location.

10 After you open the .ldif file, you can perform themappings.

11 Some default mappings are filled in for you. You can edit thesemappings.

12 Enter theActive Directory attributes into the empty fields on the right. The attributes you
enter in the fields map to the corresponding Oria attribute on the left.

13 After all the fields aremapped, click Save. All mappings are saved so that you can return to
the .ldif file later if needed. Oria will take you to themain page in AD. To continue working on
themapping, click the imported .ldif file again.

STEP 4 ASSIGNBUNDLES
After you’ve completedmapping the fields, assign bundles to users.

14 In the Map Field form, click theAssign Bundles tab. TheAssign Bundles form displays a
Search feature and lists all the users in the ‘.ldif’ file.
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15 To perform a search do the following:

a Enter in theActive Directory attribute in the Field Name box.

Note: Youmust enter the attribute correctly, no wildcards are accepted.

b In the Field Value box, enter in the criterion you want to search on. Youmust enter
the values correctly or your search results may differ. No wildcards are accepted.
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c Click Search. The user list is updated tomatching the search criterion.

d To add several search criterion, click Add another filter.

e To remove values to search on, click the Garbage Can icon next to Field Value and
then click Search again. This will update your user list.

16 After you have the list of users, assign them a bundle as follows:

a First select the users in the list you what to assign a bundle to, then from the drop
down list of bundles, select a bundle. The icon (shown below) beside the user name
indicates that the user has already been imported into Oria.
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b Click Apply. The bundle name appears in the bundle column.

c If you want to search for more users to apply a bundle to, but don’t want existing users
that have a bundle to appear in the list, select the optionDo not show users with
bundles and click Search. This step removes all users from the list that bothmeet your
search criterion and have a bundle already assigned to them.

d If you what to remove a bundle from a user, select the user and from the bundle drop
down list select None. This will remove the bundle from the user.

17 After you have assigned bundles to the list of users, click Save to save all of your work and
return to theActive Directory page or continue to work.

STEP 5DOWNLOADTHEBULK IMPORTSPREADSHEET
This form displays all of the users that have been assigned a bundle.

18 Click Download Bulk Import Spreadsheet to download a Bulk Import Excel Spreadsheet.

19 If you need tomake any changes to the bundle assignments, click Map Fields orAssign
Bundles and perform the changes.

STEP 6 IMPORTTHESPREADSHEETBACK INTO THE
PORTAL
After you complete the Bulk Import spreadsheet, return to Service Provider Portal and perform a
Bulk Import. See Bulk Import Users for details.

MAPPING EXAMPLES
Here are two examples of AD mapping; Site and Prime Phone Device Type.
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EXAMPLE 1: MAPPING ASITE
• Below is a list of sites that where created by the Service Provider in Oria for a
customer. The sites are called Ottawa, Nepean.
• In Active Directory the City location attribute for a user has the same name as the Site
name in Oria, they are both called Ottawa.
• On the “Map Fields” form the default mapping for “Site” is
‘‘physicalDeliveryOfficeName” attribute in Active Directory.
• If we look at the user’s information in Active Directory, the attribute
‘‘physicalDeliveryOfficeName” or Office, is called “KanataMitel”.
• If you were to keep the current mappings, when you open the “Bulk Import Spread
Sheet” the Site location would be empty. This is becauseOria does not have a Site
called “KanataMitel”.
• If the current mappings for a filed do not produce the correct output, the field will remain
empty in the “Bulk Import Spread Sheet”.
• We need to change themappings in the Active Directory Association “Map Fields”
form.
• Change the “Site” attribute from ‘‘physicalDeliveryOfficeName” to ‘l’ which is the
“Active Directory” attribute for “City”.
• This will ensure that all users in “Active Directory” that are in the City of Ottawa or
Nepean will beMapped to the Sites of Ottawa or Nepean in Oria.

EXAMPLE 2: PRIMEPHONEDEVICETYPE
• Tomap a Prime Phone Device Type, the device type in Active Directory must be a
Mitel supported device. See Supported Phone Sets for details.
• Active Directory has an attribute called ipPhone. The user information below shows
that they have an IP phone with the value of 5330 IP. This is a supportedMitel device.
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• On theMap Fields page, enter theActive Directory attribute ipPhone.

• When you open the Bulk Import Spreadsheet it will show all of the users that have a
supportedMitel device.
• If the device is not a supported device, the field will be empty and you will be required
to select one.
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ADMINISTER
Here are the admin activities anOria Administrator can perform:

• Resend theWelcome email
• Reset passwords
• Add a user
• Delete a user
• Generate billing reports
• Choose a licensemodel
• Choose the license counts to report
• Schedule billing reports
• Restart the Billing Scheduler
• Download billing reports
• Specify a Billing Number For a Site
• Turn off license reporting
• Manually enter licensing information
• Enable Billing Change Notification
• AddMiCollab services to existing customers

RESEND THEWELCOME EMAIL
The ResendWelcome Email option is available for single andmulti-user selection. Portal and
MiCollab passwords are reset to system generated passwords when you resend theWelcome
email.

To resend the Welcome email:
1 From the Customer Administrator portal, click the Users tab and select the recipient for the

email message.

2 In the Select an Action list, click ResendWelcomeMail.

A service provider can also create and assign other email templates, for example, important
notifications such as password updates, voicemail updates and so on. Any email template
created and assigned to a Customer is accessible from the Users tab. See “Create Custom
Email Templates” on page 59.

RESET PASSWORDS
TheOria server generates a new password and sends an email to the user with the new
password. The Customer Admin can reset the passwords from the Customer Admin portal under
Users.

Oria can reset following types user passwords:

• MiCollab password
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• Portal password
• Phone PIN
• SIP password
• Voicemail password

If you select SIP Password and you havemore than one SIP capability (for exampleMBGSIP
and SIP softphone) Oria will reset and send both passwords.

Single user selection

Selecting a single user generates a new user password for the portal. Other passwords are also
generated and sent depending one the bundle assigned to the user.

Multiple user selection

Selectingmultiple users generates a new password for the portal only. Because the other
passwords depend on bundles assigned to users, youmust select one user at a time to reset
other passwords. You can select amaximum of 25 users at a time.

To reset passwords:
1 From the Customer Administrator portal, click the Users tab and select one or more users.

2 In the Select an Action list, click Reset Password.

3 Select the type of password(s) to reset.

4 Click Reset Password & Send Email.

ADDA USER
1 From the Customer Administrator portal, click theUsers tab.

2 Click Add New.

User Profile

3 Enter the User details. Fields marked with an asterisk (*) are required. Enter aminimum of 4
characters for the username.

4 Click Next.

Service Plan

5 Click Select to choose a phone plan for the User. The chosen plan will be highlighted and
Selected will display.

6 Click Next.

Service Programming

7 Select the service details for the User. Fields marked with an asterisk (*) are required.
Notes:When you create an ACD Hotdesk user with a softphone, a shared device is
automatically created for the user.
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If you select a basic plan that does not include voicemail, you can still forward calls to
voicemail (Call Handling Rules) however the calls will go to your corporate voicemail.

8 Click Next.

Phones

9 From thePhone Type list, select the type of phone for this User.

10 From theEmergency Response Location list, select the location to which emergency call
will be sent.

11 (Optional): From the Select a predefined key template to be applied to this phone drop-down
list, choose a key template for the primary phone. Phone key templates apply to the primary
phone only.

12 (Optional): Enter theMAC Address of the phone.

13 Click Next.

Phone Keys(optional)

When you choose aMiNet phone type, a step is added to allow you to program the phone keys.
You can also edit the Prime phone key and specify the Ring type on all phones that allow key
programming.

14When you select aMiNet Phone type for example the 5330e IP, you can program the phone
keys as follows:

a Click a key on the phone diagram.

b Select what should happen when a phone user presses the key.

c Click OK.

d Repeat steps a to c to program other keys.

e Click Save.

Advanced

15 Select the call handling rules.

16 Click Save.

DELETE A USER
Deleting a user’s account is quick using the action list. The Delete User action permanently
removes the user’s profile and access to the Oria portal. You can delete one user at a time only.

To delete a user:
1 From the Customer Administrator portal, click the Users tab and select one or more users.

2 In the Select an Action list, click Delete User.

3 Click Delete.
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GENERATE BILLING REPORTS
Billing reports simply the workflow for service providers when they need to provide billing
summaries toMitel.

SERVICEPROVIDERSUBSCRIPTIONUSAGEREPORT
You can generate subscription reports and system reports from theOria portal. The Service
Provider Subscription Usage Report is an .xls formatted subscription report for the system. The
report contains a summary of the licenses in use and the counts manually entered in the editable
fields. The subscription usage report is only available for service providers and includes monthly
subscription usage for:

• MiCloud Business
• MiCloud Contact Center
• Premium Software Assurance (optional)
• MiCloud Business Move2Cloud (optional)

OPTIONAL LICENSECOUNTSFORPREMIUM SOFTWARE
ASSURANCEANDMOVE2CLOUD
The optional license counts for Premium Software Assurance andMove2Cloud are derived from
the number of Core UCC license types that the service provider has in use.

Premium Software Assurance
When the Premium Software Assurance option is enabled, the system reports indicate a
Premium Software Assurance license equal to the actual number of each of the Core UCC
license types. For example, if a service provider has 250 Entry UCC licenses in use, there will be
250 Premium Software Assurance Entry UCC licenses reported. If Premium Software
Assurance is disabled, the license count for each Premium Software Assurance license type is
0.

Move2Cloud and Core UCC Licenses
You canmanually enter the number of UCC licenses to include inMitel’s Move2Cloud promotion.
The license counts for theMove2Cloud promotion are included in the system level .xls and .xml
reports. To prevent double counts, theMove2Cloud licenses are subtracted from the Core UCC
license counts when they are reported. So the number of Move2Cloud licenses for a given type
cannot exceed the corresponding number of Core UCC licenses.

For example, Oria calculates that you are using 500 Standard IPT licenses. If you want 300 under
theMove2Cloud promotion, enter 300 for the license count field for Move2Cloud Standard IPT
field. Oria will report 200 Standard IPT licenses for UCC core and 300Move2Cloud Standard IPT
licenses.

SYSTEM BILLING REPORT
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The Service Provider Billing Report is an .xml formatted report that contains a summary of the
system licenses in use. The license counts are derived from theOria database andmanually
entered values.

CUSTOMERVSPANDVARALLOCATIONANDUSAGE
REPORTS
A report that provides a billing summary for Customers, Virtual Service Providers (VSP), and
Value Added Resellers (VAR). It contains Customer details and a summary of their bundle
allocation and usage. The billing information is downloadable in .xml format for use in a
compatible billing system.

BUNDLESALLOCATED
The portal tracks how many bundles each customer has been allocated, and of those, how many
bundles are currently being used. To view the bundle usage information, follow the steps listed
below.

To view how many bundles a customer is using:
1 Click theCustomers tab.

2 Select the customer profile.

3 In the customer's popup there is a list of the bundles allocated and used by the customer.

CHOOSE THE LICENSEMODEL
Choose either the operating expenditure (OPEX) or capital expenditure (CAPEX) licensemodel.

To choose the license model for reporting
1 Click Customers > Billing.

2 ClickConfigure.

3 Select Opex or Capex.

4 Click Save.

CHOOSE THE LICENSE COUNTS TO REPORT
You can select the type of license counts to include in billing reports.

To choose the type of license counts to report
1 Click Customers > Billing.

2 Click Configure.
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3 Select Report allocated licenses or Report use licenses.

4 Click Save.

SCHEDULE BILLING REPORTS
Schedule billing reports to run at specific intervals so that they are ready when you need them.
After a report is run, it is available in the Download Reports tab.

To schedule a billing report
1 Click Customers > Billing > Configure.

2 Click Enable Scheduled Reporting.

3 Choose the frequency, day, and start time for generating the reports.

4 Click Save.

RESTART THE BILLING SCHEDULER
You can restart the billing scheduler in two ways; reconfigure the schedule for a new time or
interval or restart the scheduler through amaintenance command.

Issue this maintenance command to restart the billing scheduler using the current configuration:

$$RESTART_BILLING_SCHEDULER$$ 

Note: If this command is run and scheduling is not enabled, the command has no effect. You
may want to use this maintenance commandwhen the server time changes for some reason
(for example, daylight savings time)

DOWNLOADBILLING REPORTS
You can download generated billing reports at any time.

1 Click Customers > Billing and then click theDownload Reports tab.

2 Click the report to download it.

SPECIFY A BILLING NUMBER FORA SITE
If you havemultiple sites with separate billing, you can specify a billing number on a per-site
basis. After you add the site billing number, it is included in billing and licensing reports.

To specify a billing number for a site
1 Click Platforms > Platform Groups.

2 Select the platform group and click Edit.

3 Click theSites tab.

4 Click theEdit icon for the site you want to add the billing number.
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5 In the Site ID field, enter a number to identify the site in billing reports.

6 Click Save.

TURNOFF LICENSE REPORTING
Turn license reporting on or off through the Customers tab in Billing.

To turn off license reporting for a customer
1 Click Customers > Billing and then click theCustomers tab.

2 In the table, find the customer, go to theReporting Status column and select On orOff.

3 Click Save.

MANUALLY ENTER LICENSE INFORMATION
You canmanually enter the license counts that Oria does not automatically calculate in the Oria
portal. The license counts that Oria does calculate from its database appear as read-only fields in
the License Information page. Any counts that aremanually entered in the editable fields are also
stored in the Oria database.

To manually enter licensing information:
1 Select Customers > Billing.

2 Click theEdit Licensing link.

3 Edit the corresponding licenses and click Save.

ENABLE BILLING CHANGE NOTIFICATION
Billing change notification settings are available for Service Provider Administrators who hold
Advanced privileges in the Service Provider Portal. The Billing Change Notification feature
displays a warningmessage to Customer Administrators when the action they are about to take
changes the Service Agreement with the Service Provider and increases billing. Billing change
notification settings include a customizable default message.

When you create a new customer, billing change notification is disabled by default. When an
existing customer is upgraded to Oria 5.2 and later, billing change notification is enabled by
default.

Billing change notification is available for the following actions:

• Create a user
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• Change a user bundle
• Create a group
• Create an auto attendant or auto attendant action
• Create a call flow
• Create a general mailbox

To set billing change notification
1 Click System > Advanced and then click theBilling Change Notification tab.

2 Select the actions you want billing notification for.

3 Customize the billing notificationmessage:

a Select the language for themessage.

b Customize themessage.

c Repeat a. and b. for any other language.

4 Click Save.

To change billing notification for a customer
1 From theCustomers tab, click View Customers.

2 Select the customer and click theEdit icon.

3 Click theService Bundles tab.

4 UnderBilling Change Notification, select or deselect Customer must confirm any
changes that will affect their billing.

ADDMICOLLAB SERVICES TO EXISTING
CUSTOMERS

Perform the following operations to upgrade an exiting customer toMiCollab Client:

1 AddMiCollab Client to the Platform.

2 Create a bundle that includes MiCollab Client.

3 Assign theMiCollab Client bundle to the customer.

4 Assign theMiCollab Client bundle to users.

ADDA RESILIENT MIVOICE BUSINESS INSTANCE TO
ANEXISTING PLATFORMGROUP

If you set up a customer on a single MiVoice Business instance, you can add another MiVoice
Business instance to the platform group later to make it resilient. When you add aMiVoice
Business instance to an existing platform group, all users are automatically configured into the
new resilient MiVoice Business instance.
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SCHEDULEDMAINTENANCEDURINGMIVOICEBUSINESS
RESILIENCYSETUP
Do not execute and disable any scheduledmaintenance on theMiVoice Business when you run
theMiVoice Business Resiliency option in Oria. For example, if the DBMS CHECK command
starts to execute during that time, it will lock theMiVoice Business instance and cause errors in
updating users. If you encounter errors, youmay try the operation again. This second try only
updates those users that failed the first time. If you would like to set all users' resiliency values
again, instead of only those that failed, then delete the task from the background task results list
and run the Resiliency option again.

To add a resilient MiVoice Business instance
1 Log out any Hotdesk users before adding a resilient MiVoice Business.

2 From thePlatforms tab, click Platform Groups.

3 Select the customer and then click theEdit icon.

4 Click theSites tab.

5 Do the following:
• Click theEdit icon for the site that you want to apply resiliency.
• Click the MiVoice Business tab.
• Select the resilient MiVoice Business.

6 Click Save.

All user devices on the primary MiVoice Business instance are updated with the new resilient
MiVoice Business instance. The customer is locked frommaking changes during this time.

To remove a resilient MiVoice Business
1 From thePlatforms tab, click Platform Groups.

2 Select the platform group and then click theEdit icon.

3 Click theSites tab.

4 Click theEdit icon next to the customer site that contains the resilient MiVoice Business
instance.

5 Click the Mivoice Business tab.

6 In theResilient MiVoice Business drop-down list, select No Resilient MiVoice Business.
Note: All user devices on the primary MiVoice Business instance are updated whenMiVoice
Business resiliency is removed. The customer is locked frommaking changes during this time.

7 Click Save.
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MAINTAIN
Here are themaintenance activities that need to take place on a regular basis:

BACK UP ANDRESTORE THEORIA DATABASE
There are two backupmethods available to back up theOria database, depending on your needs:

• MSL backup
• Oria backup

Both offer complete backups but theMSL Backup offers the advantage of automated scheduled
backups. TheOria Backupmethod is useful for softwaremigrations and when a database needs
to be sent to Mitel support.

CAUTION: The above backupmethods are not compatible with each other. AnMSL
Backup can only be restored using theMSLRestore capability. AnOria Backup can only
be restored using the Oria database restore capability.

MSLBACKUPANDRESTORE
AnMSL backup is a complete representation of anMSL server at the time of backup. It includes
MSL and the application databases. It does not include any of the software application blades
installed onMSL. This means that if a new system needs to be restored, MSL, the backup-file,
and the Oria Blade will need to be installed. AnMSL backupmay be restored to an existing
system without reinstallingMSL or Oria (restoring a database that originated or a greater version
of Oria than the restore target will result in system failure).

To schedule automatic MSL backups:

ScheduledMSL backups use the network file server option from with theMSL Server Manager.

Note: This procedure also backs up all application data through theMSL backup feature.
Performing a separate backup of the Oria databasemay not be necessary, depending on local
administration/maintenance protocols.

1 Log in to theMSL Server Manager using a supported browser with the user name and
password when initially configuring theMSL server.

2 Under Administration, click Backup.

3 From the Select an action drop-down list, click Configure network backup.
Note: Selecting the Backup to Desktop option will back up the data to the local
workstation. Scheduled backups cannot be performed with this option.

4 Click Perform.

5 In theBackup Server Configuration area, configure the server where the backup file will be
stored:

• In the IP Address field, enter the IP address of the file server where the backup will be
stored.
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• In the Sharename field, enter the name of the shared folder where the backup file will
be stored. (For example, "Backups".) The shared folder must have permissions set to
"Full Control".
• In the Username field, enter the username to use when connecting to the backup
server.
• In theDomain or Workgroup Name field, enter the domain or workgroup name of the
server. (For example, mitel.com.)
• In the Password field, enter the password to use when connecting to the backup
server. Available storage space is displayed.

6 In the Maximum number of backup files to keep field, enter themaximum number of
backup files to keep (1-999) on the server (default is 5). When the number of stored files
reaches this maximum count, the oldest version is deleted.

7 In theBackup Schedule area, select the frequency with which to perform backups (Daily,
Weekly, Monthly, Never). Backup file names will include timestamps in the format:
mslserver_<hostname>_yyyy-mm-dd_hh-mm.tgz)

• For Daily backups, select a time of day (hour, minute, AM/PM)
• ForWeekly backups, select a time of day, and day of the week
• For Monthly backups, select a time of day, and day of themonth
• To disable regularly scheduled backups, click Disabled.

8 To test the backup configuration, or to run an immediate backup, click Backup Now.

9 Click Save to save the schedule information.

See theMitel Standard Linux Installation and Administration Guide for additional information.

RESTORE THE ORIA DATABASE FROM AN MSLBACKUP

You need the following information and equipment to restore a database:

• Installer PC
• MSL system IP address
• MSL Server Manager username and password

There are twomethods for restoring the Oria database from anMSL backup:

• Use the "Restore" option when re-installingMSL.
• Use the Command Line Interface by logging in to theMSL Server Console and select
the "Restore from backup" option. See theMitel Standard Linux Installation and
Administration Guide for details.

CAUTION: Youmust restart the Oria application after restoring a database. Service will
be LOST during this reboot.

UPGRADE THEORIA SOFTWARE
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Follow these steps to upgrade from aminimum of Oria 4.0.275 to Oria 5.3. Make sure that you
upgrade from the latest Oria 4.0 support build. Contact product support for the latest patch
release. See the latest release notes for details.

If you are upgrading from an earlier release of Oria, for example Oria 3.0, contact Mitel
Professional Services for assistance.

Note: If you are using system speed call, youmust migrate to DID services using the Oria
migration outlined in Oria 4.0 beforemigrating to Oria 5.3.

Important: TLS 1.0 has been found to be vulnerable to a number of security attacks. As such,
Oria 5.3 disables support for TLS 1.0 by default. Mitel does not recommend using TLS v1.0.
However, should you need to enable support for TLS v1.0, login to theMSL server manager for
the server at:
[http://<address]http://<address of Oria server>/server-manager,
go toSecurity > Web Server > TLS and select Allow TLS v1.0.

UPGRADEONAPHYSICAL SERVER (ORIA 5.0 OR5.1 OR
5.2 TO ORIA 5.3)
Note: After an upgrade, all Oria history is removed. For example, Active Directory and Bulk
Import history.

Step 1 Prepare for the upgrade
1 Order anOria license.

2 Make sure that the Oria server has Internet access to perform aDNS lookup and for access to
port 22 of Mitel AMC.

3 Test access to AMC:

a ssh to the Oria server and login at root level using the same password as admin.

b Ping sync.mitel-amc.com and register.mitel-amc.com

c If no IP address is resolved, check the DNS.

4When theOria license is available in AMC, create a new Oria ARID and apply the license to it.
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Step 2 Perform an Oria backup
1 Log into the current Oria server using Server Manager.

2 Perform a backup to the desktop.

3 In the Status panel, register the server with the ARID created earlier.

Step 3 Upgrade the MSL blade to 10.5 version (see release notes for the latest
compatible version)
1 InServer Manager, go to the blades Blades panel.

2 Upgrade theMSL blade.

3 Clear the report after the upgrade.

4 Reboot server from Reconfigure tab in Server Manager. Wait until the server is restarted.

Step 4 Upgrade Oria
1 InServer Manager, go to the blades Blades panel.

2 Upgrade theOria blade. Wait until the upgrade is finished.

3 Clear the report and ensure that there are nomore upgrades listed.

4 Update the default Oria password on first access.

UPGRADEONAPHYSICAL SERVER (ORIA 4.0.275 TO ORIA
5.3)

Step 1 Prepare for the upgrade
1 Order anOria license.

2 Make sure that the Oria server has Internet access to perform aDNS lookup and for access to
port 22 of Mitel AMC.

3 Test access to AMC:

a ssh to the Oria server and login at root level using the same password as admin.

b Ping sync.mitel-amc.com and register.mitel-amc.com

c If no IP address is resolved, check the DNS.

4When theOria license is available in AMC, create a new Oria ARID and apply the license to it.

Step 2 Perform an Oria backup
1 Log into the current Oria server using Server Manager.

2 Perform a backup to the desktop.

Step 3 Upgrade the MSL blade to 10.5 version (see release notes for the latest
compatible version)
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1 Place the CD in the server optical drive.

2 Boot from the appropriate drive, and select theUpgrade option during the installation process.

Step 4 Upgrade Oria
1 Place the CD in the optical drive.

2 Login into the Server Manager using a supported browser with the user name 'admin' and the
root password you gave when configuring theMSL server. The Server Manager is accessed
by entering the following URL:http://<www.hostname> OR <IP address of the MSL
Server>/server-manager.

3 Click onBlades, located in the left-side panel under the ServiceLink heading.

4 Click Update List to ensure an up-to-date listing of software blades.

5 Click the Install link, located beside the Oria blade name.It may take a few minutes for the
software to install.

6 Test the installation:

7 Click onOria, located in the left-side panel under theApplications heading.

8 If Oria is not visible, refresh the browser.

9 Click Launch, located in themain window.

Step 5 Register the server with the ARID
• In the Status panel, register the server with the ARID created earlier.

Step 6 Run the Oria post-upgrade maintenance commands
1 Login to the Oria 5.3 service provider portal (http://a.b.c.d/konos/sp/spLogin.do). Replace

a.b.c.d with the Oria server IP address or FQDN.

2 Enter this URL in the same active service provider browser session
(https://a.b.c.d/konos/commands.jsp) Replace a.b.c.d with the Oria server IP address or
FQDN. This will open upOria Service Provider maintenance commandwindow.

3 Run the following commands in the Oria Service Provider portal to enable features in the
Customer Administrator portal: (run again?)

In the command field, enter the following commands individually and click on Submit after each
command. Replace custId1 with the assigned customerWebID in Oria.

• $$GET BUSINESS HOURS$$ custId1

• $$GET SUPERVISED TRANSFER$$ custId1

• $$SET FACS$$ custId1

To issue the commands for multiple customers, run these commands:

• $$GET BUSINESS HOURS$$ custId1, custId2

• $$GET SUPERVISED TRANSFER$$ custId1, custId2

• $$SET FACS$$ custId1, custId2
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To apply the commands to all customers in the Oria database, run these commands:

• $$GET BUSINESS HOURS$$ ALL

• $$GET SUPERVISED TRANSFER$$ ALL

• $$SET FACS$$ ALL

Any customer that is usingMiVoice Business (MiVB) is upgraded as part of theMiCloud
Business 3.1 toMiCloud Business 3.2 upgrade. To updateMiVB versions, go to the Oria Service
Provider maintenance commandwindow and run the following command:

$$UPDATE MCD VERSION$$ CUSTOMER, custId

4 See theMigrate toMiCloud 3.2 Flow Through Provisioning section if you upgraded from
MiCloud Business 3.1 toMiCloud Business 3.2. (applies if upgrading fromMiCloud Business
2.0 - include in procedure 2)

UPGRADEONAVIRTUALMACHINE
For virtual deployments in a VMware environment, MSL software is packaged with the
application software and delivered as anOVA file which can be installed on a vSphere client
using the Deploy OVF Template wizard.

Notes: If you are upgradingMiCollab andOria to MiCloud 2 from a previous version, feature
profiles will not automatically be created onMiCollab. To create the feature profiles onMiCollab
youmust edit and save the customer andOria will create the Feature Profiles on theMiCollab
Client.
Users are not created from the old Standard IPT bundle when you upgrade toMicollab Version
7.1 and up. To be able to add the users, youmust manually update the Record ID onMiCollab
in the location where IPT licenses are added.

Optionally you can follow the same upgrade process as the physical server upgrade with the
following exception:

• Upgrade theMVF blade after theMSL upgrade but before the reboot.

Note: After an upgrade, all Oria history is removed. For example, Active Directory and Bulk
Import history.

Step 1 Back up the virtual machine instance

1. In the vSphere client, right-click the virtual appliance name and select ShutdownGuest.

2. Click File > Export > Export OVF Template.

3. Enter the name of the OVF template file and the directory where you want to save it.

4. Select one of the following options:

• Physical Media (OVA): to export a single .ova file (recommended)
• Web: exports multiple files

5. Select one of the following Format options:

• Single File (OVA): to export a single .ova file (recommended)
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• Folder of Files (OVF): exports multiple files

6. Click OK. MSL automatically configures the NIC address for the new virtual machine.

Step 2 Perform a full MSL backup
1 Log in as "admin".

2 Access the server console from the server itself or remotely using an SSH client.

3 From the console, select the option to Perform backup.

4 Select a destination to store the backup, for example, your desktop or local network file server.

5 If backing up to a local network file server do the following:
• Enter the IP address of the file server where the backup will be stored.
• Enter the domain or workgroup name of the server. For example, mitel.com.
• Enter the name of the shared folder where the backup file will be stored. (For example,
"Backups".) The shared folder must have permissions set to "Full Control".
• Enter the Optional Directory Path where the backup will be stored. If you leave this
field blank, the file will be stored at the root of the shared folder.
• Enter the username to use when connecting to the backup server.Enter the password
to use when connecting to the backup server. Estimated backup size and available
storage space are displayed.

6 Click Proceed.When the backup is complete, file verification is performed automatically.

7 Click Continue.

Step 3 Deploy the Oria Virtual Appliance

The .ova file you downloaded fromMitel OnLine contains theMSL operating system, the
application software, and VMware Tools (a suite of utilities to enhance performance).

1 Launch the vSphere Client on the network PC:
• Click Start > All Programs.
• Click VMware > VMware vSphere Client.
• Enter the IP address or hostname of the Hypervisor ESX/ESXi Host server OR enter
the IP address or hostname of the vCenter Server.
• Enter your username and password.
• Click OK.

2 In the vSphere Client application, click File > Deploy OVF Template. (The .ova file you
downloaded is a template file in OVF format.)

3 In the Deploy OVF Template screen, specify the storage location of the .ova file you
downloaded.

4 Specify the Source Location for the OVF template file (.ova file extension):
• To deploy from a file on the local PC or from a network share, click Browse and
navigate to the file.
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• To deploy from aURL (if the file is on the Internet or is accessible through a web
browser) enter the URL of the file location.

5 Click Next. TheOVF Template Details screen appears. The information shown is derived from
the .ova file to provide a “check” for correct application and version. Note that the Download
size is only an estimate until a deployment configuration is selected later in the process.

6 Click Next.

7 Click Accept to accept the end-user license agreement, and then click Next.

8 Enter ameaningful name for the virtual appliance, or accept the default name, and then click
Next.

9 Click Next. The following three steps are dependent on your configuration.
• If you are using the optional vCenter Server, select the appropriate Host/Cluster for
this deployment and then click Next.
• If you are using the optional vCenter Server, select the appropriate Resource Pool for
this deployment and then click Next.
• If multiple Datastores are available, select the Datastore for the vNuPoint instance,
and then click Next.

10 In the Disk Format screen, select Thick provision Lazy Zeroed.

11 Click Next.

12 Configure the network mapping. (This screen is only displayed if the network defined in the
OVF template does not match the name of the template on the host to which you are
deploying the virtual application.) If required, contact your Data Center administrator for more
details on which Network Mapping to use. The required settings are:

• Application: Select Restore from backup.
• LAN: Enter the IP Address, LAN Netmask, and Default Gateway Address.

Note: If you want to use the IP Address of your existing Oria server, ensure that it
is shut down. If not, the new updated Oria server will detect an IP conflict, and
disable its network interface, until the original Oria server is off the network.

13 Click Next. The Deploy OVF Template Ready to Complete screen appears.

14 Review the information and then click Finish.

15When deployment is complete, click Close. The new virtual machine appears in the inventory
list in the left-hand pane.

16 Select the new virtual machine and power up the virtual machine.

17 Open the virtual machine console.

18When the system prompts you with "Do you wish to restore from backup?", click Yes. The
MSL console will present 3 choices of Upgrade. DO NOT choose "Restore from Running
server". Choose one of the other options to retrieve your Oria Backup file, into this new Oria
server. After you have restored the Oria MSL Backup, you will be prompted to Reboot. Again,
ensure that the original Oria (with the same IP address as this updated Oria), is shutdown
before booting up the new restored Oria server.
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Note: TheOria Service Provider Portal may not be available immediately after theMSL Server
Manager is available. It may take a few minutes for all of the Oria Services to start.

19 Select Restore from Network Server.You will be prompted to select a network interface to
use for the restore (LAN orWAN), the address and netmask of the local MSL server, the
address, gateway and domain name of the backup server, the folder name containing the
backup file, and the username and password required to log in to the backup server.

20 Use VSphere, or VCentre to change the virtual machinememory allocation to 8GB.

21When the restore is complete, select Reboot.
Important: If you want to use the IP Address of your existing Oria server, ensure that it is shut
down. If not, the new updated Oria server will detect an IP conflict, and disable its network
interface, until the original Oria server is off the network.

Step 4 Apply the Oria ARID and sync with the AMC
1 Make sure you have created the Oria ARID on the AMC.

2 Apply the Oria ARID inMSL Server Manager.

3 Synchronize to the AMC.

Step 5 Run the Oria post-upgrade maintenance commands
1 Login to the Oria 5.3 service provider portal (http://a.b.c.d/konos/sp/spLogin.do) <<replace

a.b.c.d with the Oria server IP address or FQDN>>

2 Enter this URL in the same active service provider browser session
(https://a.b.c.d/konos/commands.jsp) <<replace a.b.c.d with the Oria server IP address or
FQDN>> This will open upOria Service Provider maintenance commandwindow.

3 Run the in the

In the command field, enter the following commands individually and click on Submit after each
command. Replace custId1 with the assigned customerWebID in Oria.

• $$GET BUSINESS HOURS$$ custId1

• $$GET SUPERVISED TRANSFER$$ custId1

• $$SET FACS$$ custId1

To issue the commands for multiple customers, run these commands:

• $$GET BUSINESS HOURS$$ custId1, custId2

• $$GET SUPERVISED TRANSFER$$ custId1, custId2

• $$SET FACS$$ custId1, custId2

To apply the commands to all customers in the Oria database, run these commands:

• $$GET BUSINESS HOURS$$ ALL

• $$GET SUPERVISED TRANSFER$$ ALL

• $$SET FACS$$ ALL
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4 Follow the steps inMigrate toMiCloud 3.2 Flow Through Provisioning if you upgraded from
MiCloud Business 2.0 toMiCloud Business 3.2.

MIGRATETOMICLOUD3.2 FLOWTHROUGH
PROVISIONING
Any customer that is usingMiVoice Business (MiVB) is upgraded as part of theMiCloud
Business 2.0 toMiCloud Business 3.2 upgrade.

Important: After the upgrade youmay need to clear your browser cachememory for example,
when performing a task such as creating or changing a bundle. To clear your browser cache do
one of the following:
1 (preferred) Force reload the page (usually by pressing: CTRL + F5)
2 Clear browser cache
3 Reboot Oria

To updateMiVB versions, go to the Oria Service Provider maintenance commandwindow and
run the following command:

$$UPDATE MCD VERSION$$ CUSTOMER custId

If you upgraded the platforms fromMiCloud 2.0 to aMiCloud 3.2, run ONE of the following
commands:

Note: Make sure that you run the command BEFORE switching the configuration from FQDN
to IP (The FDQN is used to also update any MiVB references in correspondingMBGs). If the
FQDN is changed before running the command, the administrator will have to go directly into
theMBGs and change theMiVB reference from FQDN to IP.

NAT: Run the followingmaintenance command for moving from an FQDN to an IP address
which is required with MiCloud 3.2 flow through provisioning.

• $$UPDATE MCD CUSTOMER HOST NAME$$ <Management Host Name IP
Address>, <New Customer Host Name>

For example:

$$UPDATE MCD CUSTOMER HOST NAME$$ mmg.fqdn1.public.com, 192.168.20.1

non-NAT mode: Change the Host Name from FQDN to an IP address. In non-MMG, there is no
Management and Customer Host Names, just one Host Name for theMiVB configuration (in
MiVoice Business tab in the Platform Groups UI).

Use this maintenance command to change the Host Name from FQDN to an IP address:

• $$UPDATE MCD HOST NAME$$ <Existing Host Name FQDN/IP
Address>, <New Host Name>

For example:

$$UPDATE MCD HOST NAME$$ fqdn1.com, 10.168.20.1

Verify that the commandwas successful by viewing theMiVoice Business tab in Platform
Groups for the correspondingMiCollab platform.
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